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Welcome 

  Welcome 
 

 
 
Welcome to the PATGuard 3 Help file. PATGuard 3 is the ultimate way to record, store and report on a 
range of health and safety requirements including PAT testing, risk assessments and other workplace tests 
and inspections. You can tag records with images as visual evidence, schedule retest periods and produce 
professional reports and certificates for total traceability. 
 
PATGuard 3 is compatible with a wide range of portable appliance testers, including the Seaward Apollo 
600 safety management tool. For a full list of compatibility refer to the Tester Compatibility page. 
 
About PATGuard 
 
For more information about PATGuard 3, refer to About PATGuard 3 page. 
 

  How to use the Help file 
 
To navigate the Help file, click on the links that appear throughout the document to find out more 
information about a particular topic. You can also navigate the Help file using the built-in Table of Contents 
or by using the Search function. 
 
Accessing the Help file 
 
The Help files can be accessed by selecting Help Topics from the Help Menu. 
 

 
Help Topics - Help Menu 

 
Context-sensitive help 
 
For help on a particular topic, the Help file can also be accessed by pressing the F1 key at any time. 
 
What if I still can't find what I need? 
 
If you have referred to the Help file and are still in need of assistance, please refer to the Support page. 
 

  Getting Started 
 
For help on getting started, including Installing and Activating PATGuard 3 and Setting up a Database, 
please refer to the Getting Started section. For help in navigating around the user interface, please refer to 
the Navigating PATGuard 3 section. 
 
Setup Wizard 
 
PATGuard 3 contains a Setup Wizard to help you get up and running. For more information, refer to the 
Setup Wizard page. 
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About PATGuard 3 

  About PATGuard 3 
 
PATGuard 3 offers total traceability when it comes to maintaining portable appliance testing records, 
enabling images taken with Apollo 600 or any camera or phone to be tagged against sites, locations, asset 
IDs and test results – providing evidence of visual inspection. 
 
Tagged images can be included in the vast range of reports that PATGuard 3 The Health and Safety 
Edition can create. These are easily stored, printed or emailed. 
 
A Risk-Based Approach 
 
Universal and electrical risk assessment tools are built into PATGuard 3. These tools ensure a risk-based 
approach is taken to portable appliance testing; automatically determining retest periods proportionate to 
risk for assets as required by the IET Code of Practice. 
 
The universal risk assessment tool records details of any workplace hazard, calculating risk scores and 
scheduling corrective actions has never been simpler. 
 
Complete Health and Safety Management 
 
A range of additional health and safety test and inspection certificates are built into PATGuard 3, allowing 
records for the inspection of emergency lighting and fire alarm systems to be kept and easily managed. 
 
Compatible with Apollo 600 
 
PATGuard 3 is the ultimate companion for Apollo 600, a total safety management tool. When used with 
Apollo 600 it is simple to upload and download reports, images, test results and risk assessments to and 
from the tester via Bluetooth or USB connectivity. 
 
As well as being compatible with all Seaward PAT testers, PATGuard 3 is also suited for use with a range 
of other manufacturer's testers with download capability. For a full list of compatibility refer to the Tester 
Compatibility page. 
 
About Screen 
 
To view the About Screen, select the About PATGuard option from the the Help Menu. 
 

 
About PATGuard - Help Menu 

 
The About Screen displays the version and revision of PATGuard 3 that you are using, along with the 
Licence Agreement.  
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About Screen 

 
To view details about your PATGuard 3 licence, select Licence... from the About Screen. 

What's New & Revision History 

  What's New 
 
PATGuard 3 has been completely updated to include: 
 
• A built in universal risk assessment tool 
• Ability to determine retest periods using electrical risk assessment tool 
• Ability to create and print a range of health & safety certificates 
• Compatibility with the Apollo 600 safety management tool 
 
Future updates are free to existing registered PATGuard 3 subscribers. 
 
Revision History 
 
To see which revision of PATGuard 3 you are currently running, refer to the About Screen. 
 
Version 3.0 
 
Version 3.0 is the initial release version of PATGuard 3. 

PATGuard 3 Versions 

  PATGuard 3 Versions 
 
PATGuard 3 is available in two different versions, Elite and Elements. The version you are currently 
running can be found on the About Screen. 
 
The features of the different versions are as follows: 
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PATGuard 3 Versions 

Tester Compatibility 

  Tester Compatibility 
 
Download Compatibility 
 
PATGuard 3 (Elite and Lite Versions only) can download data from the following testers: 
 
• Apollo 600 
• Europa  
• Europa Plus  
• Europa PAC Plus  
• Europa XE  
• Europa XE Plus  
• Supernova  
• Supernova Elite  
• Supernova Plus 
• Supernova XE  
• Supernova XE Plus 
• PrimeTest 300 
• PrimeTest 350 
• Clare HAL 
• Clare HAL Combi 
• Clare SafeCheck 8 
• Clare SafeTest Luminaire 
• Clare SafeTest Manufacturing 
• Emona Maestro 
• PAT1000  
• PAT1000S  
• PAT1000X  
• IT1000  
• PAT2000  
• PAT2000i  
• PAT2000iee  
• SEN60204 
• Avo PAT4* 
• Avo PAT4F* 
• Robin SmartPAT 5000 
• Robin SmartPAT 5500 
• MetrohmMicroPAT+ 
• Metrel OmegaPAT 
• Metrel BetaPAT 
• Ethos 9600  
• Ethos 9500  
• Ethos 9300  

 
 

 

 
* Requires download through the Parallel Port via a Parallel to Serial Adaptor, not available from Seaward. Contact Avo for download 
cable and adaptor requirements. 

 
Upload Compatibility 
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PATGuard 3 (Elite Version only) can upload data to the following testers: 
 
• Apollo 600 
• Europa 
• Europa Plus 
• Europa XE 
• Europa XE Plus 
• PrimeTest 300 
• PrimeTest 350 
• Supernova 
• Supernova Elite 
• Supernova Plus 
• Supernova XE 
• Supernova XE Plus 
• IT1000 
• PAT2000i 
• PAT2000iee 
• Ethos 9500 
• Ethos 9600 
• Emona Maestro 
 
For specific information about your tester, please refer to your tester instruction manual. 

Getting Started 

  Getting Started 
 
Once you have reviewed the Licence Agreement and are ready to install PATGuard 3, follow the steps 
below to get started: 
 
Installing PATGuard 3 
 
• Installing on a standalone PC 
• Installing on a network Server 
• Installing on a network Workstation 
 
Activating PATGuard 3 
 
• Activate Online 
• Activate by Phone, Email or Fax 
• Evaluation Period 
 
Setup Wizard 
 
• Setting up a Database 

o Create a new database 
o Select an existing database 
o Import a legacy database 

• Setup Options 
o Company Details 
o User Accounts 
o PAT Options 

§ Code Abbreviations 
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o Asset Groups 
 
Click on the links above for more information about each option.  
 
If you encounter problems getting started with PATGuard 3, please refer to the Support page. 

Installing PATGuard 3 

  Installing PATGuard 3 
 
Once you have reviewed the Licence Agreement and are ready to install PATGuard 3, select an option 
from below to learn more about installing PATGuard 3 on your system: 
 
Installing PATGuard 3 
 
• Installing on a standalone PC 

o Installing on a PC without internet access 
• Installing on a network Server 
• Installing on a network Workstation 
 
Click on the links above for more information about each option.  
 
If you encounter problems installing PATGuard 3, please refer to the Support page. 

Installing on a standalone PC 

  Installing on a standalone PC 
 
Once you have downloaded PATGuard 3, double-click the downloaded file to install PATGuard 3 on your 
system. Click Next > on the following screen to start the installation process. 
 

 
Installation Screen 1 

 
Review the Licence Agreement and click Next > to continue. 



PATGuard 3 

11 / 153 

 

 
Installation Screen 2 

 
For a standalone PC select Standalone PC and click Next > to continue. 

 

 
Installation Screen 3 

 
Either leave the installation directory as the default or change it if you wish and click Next > to continue. 
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Installation Screen 4 

 
Click Next > to continue. 
 

 
Installation Screen 5 

 
You will be asked to confirm you options. Click Install to continue. 
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Installation Screen 6 

 
You will be shown the progress of the installation. 

 

 
Installation Screen 7 

 
When the installation has finished, click Finish to launch PATGuard 3. 
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Installation Screen 8 

 
PATGuard 3 will now start and the Login screen appear. Click OK to launch PATGuard 3. 
 
Installing on a PC without internet access 
 
To install on a PC without internet access, you will first need to download the PATGuard 3 installation files 
on another PC and copy these to a CD or USB memory stick.  
 
If you encounter problems installing PATGuard 3, please refer to the Support page. 

Installing on a network Server 

  Installing on a network Server 
 
Once you have downloaded PATGuard 3, double-click the downloaded file to install PATGuard 3 on your 
system. Click Next > on the following screen to start the installation process. 
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Installation Screen 1 

 
Review the Licence Agreement and click Next > to continue. 
 

 
Installation Screen 2 

 
For a network Server select Network Install and click Next > to continue. 
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Installation Screen 3 

 
Select an installation location that is accessible to other computers on your network. Click Next > to 
continue. 

 

 
Installation Screen 4 

 
Follow the remaining on-screen instructions to install PATGuard 3 on your network Server. 
 



PATGuard 3 

17 / 153 

If you encounter problems installing PATGuard 3, please refer to the Support page. 

Installing on a network Workstation 

  Installing on a network Workstation 
 
To install PATGuard 3 on a network Workstation, browse to the location specified when you installed on a 
network Server. Locate and run the file netsetup.exe to install PATGuard 3 on a network Workstation. Click 
Next > on the following screen to start the installation process. 
 

 
Installation Screen 1 

 
Review the Licence Agreement and click Next > to continue. 
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Follow the remaining on-screen instructions to install PATGuard 3 on your network Workstation. 
 
If you encounter problems installing PATGuard 3, please refer to the Support page. 

Activating PATGuard 3 

  Activating PATGuard 3 
 
Once you have installed PATGuard 3 you will see the Activation screen. You can choose to either Activate 
PATGuard 3 or continue using the 30 day Evaluation Period. 
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Activation Screen 

 
If you have already purchased PATGuard 3 and wish to activate it now you can choose to: 
 
• Activate Online 
• Activate by Phone, Email or Fax 
 
You will need to have your serial number available to activate PATGuard 3. If you do not have a serial 
number, you can select Buy a Serial Number to purchase one.  
 
You can also choose to make use of the 30-day Evaluation Period and activate PATGuard later.  
 
If you encounter problems activating PATGuard 3, please refer to the Support page. 

Activate Online 

  Activate Online 
 

To activate PATGuard 3 online, select I have a Serial Number and I want to activate PATGuard 3 and 
click Next on the Activation screen. You will need to have your serial number available to activate 
PATGuard 3. If you do not have a serial number, you can select Buy a Serial Number to purchase one.  
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Activation Screen 1 

 
Select Online Activation on the following screen and click Next. 
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Activation Screen 2 

 
Enter your details on the following screen and click Next. 
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Activation Screen 3 

 
PATGuard 3 is now ready to activate PATGuard 3. If you use a proxy server to access the internet you will 
need to enter these details on the following screen by clicking Change Proxy Settings (only for expert 
users). See Entering Proxy Server details if required, otherwise click Next. 
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Activation Screen 4 

 
PATGuard 3 will now connect to the Activation Service. 
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Activation Screen 5 

 
The following screen will be displayed when Activation is completed successfully. You will not need to enter 
multiple Activation Keys unless requested to. Click Next or End to close the Activation Screen. 
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Activation Screen 6 

 
Entering Proxy Server details 
 
If you use a Proxy Server to access the internet, you will need to enter these details into the activation 
screen. Select Change Proxy Settings (only for expert users). By default the Proxy Server settings will 
be the same as those set in Internet Explorer. To change the Proxy Server settings, select Use Proxy 
Server and enter the details in the Proxy Server and Proxy Port boxes. 
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Proxy server details 

 
If you encounter problems activating PATGuard 3, please refer to the Support page. 

Activate by Phone, Email or Fax 

  Activate by Phone, Email or Fax 
 
The simplest way to activate PATGuard 3 is to Activate Online. However if you do not have an internet 
connection or wish to activate in a different way, you may choose to Activate by Phone, Email or Fax. 
 
To activate PATGuard 3 by Phone, Email or Fax, select I have a Serial Number and I want to activate 
PATGuard 3 and click Next on the Activation screen. You will need to have your serial number available to 
activate PATGuard 3. If you do not have a serial number, you can select Buy a Serial Number or contact 
Seaward or your Distributor to purchase one. 
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Activation Screen 1 

 
Select E-Mail Activation, Fax Activation or Phone Activation on the following screen and click Next. 
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Activation Screen 2 

 
Enter your details on the following screen and click Next. 
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Activation Screen 3 

 
Follow the instructions provided to finish the activation process. Unlike Activating Online, you will be 
provided with an Activation Key that you will need to enter to complete the process..  

 
If you encounter problems activating PATGuard 3, please refer to the Support page. 

Evaluation Period 

  Evaluation Period 
 
PATGuard 3 can be used as a free trial for a period of 30 days. During the Evaluation Period the activation 
screen will open when you start PATGuard 3 and will display the number of days left in the Evaluation 
Period. 
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Activation Screen - Evaluation 

 
Once the evaluation period is over PATGuard 3 will revert to a read-only mode and you will not be able to 
add to or amend the database until you Activate PATGuard 3. 
 
If you have already purchased PATGuard 3 and wish to activate it now you can choose to: 
 
• Activate Online 
• Activate by Phone, Email or Fax 
 
If you encounter problems activating PATGuard 3, please refer to the Support page. 

Setup Wizard 

  Setup Wizard 
 
The Setup Wizard runs the first time PATGuard 3 starts, and can also be accessed by clicking Setup 
Wizard in the Help Menu. 
 

 
Setup Wizard - Help Menu 
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The Setup Wizard will first guide you through the process of Setting up a Database. It will then take you to 
the Setup screen to allow you to enter your Company Details, add User Accounts, and configure PAT 
Options and Asset Groups. 
 
Please continue to the Setting up a Database page. 

Setting up a Database 

  Setting up a Database 
 
The first step in the Setup Wizard is Setting up a Database, which will be used to store all of your 
PATGuard 3 data. 
 

 
Setup Wizard 

 
The Setup Wizard gives three options for Setting up a Database: 
 
• Create a new database 
• Select an existing database 
 
Your choice will depend on whether you already have a PATGuard database that you wish to use or if you 
wish to start from a blank database.  
 
Click on the links above for more information about each option. 

Create a new database 

  Create a new database 
 
If you do not have an existing PATGuard database that you want to use, this is the option for you. If it is 
not, see Select an existing database. 
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Create a new database - Setup Wizard 

 
Enter new database name 
 
After selecting Create a new database and clicking Next, the first step is to browse to the location you 
wish to store your database and enter a filename for the new PATGuard 3 database in the Enter New 
Database Name window.  

 

 
Enter new database name 
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After clicking Save the Setup Wizard will take you to the Setup options window.  
 
Please continue to the Setup page. 

Select an existing database 

  Select an existing database 
 
If you have an existing PATGuard database that you want to use, this is the option for you. If it is not, see 
Create a new database. 

 

 
Select an existing database - Setup Wizard 

 
Select existing database 
 
After selecting Select an existing database and clicking Next, the first step is to browse to the location 
where your existing database is stored.  

 



PATGuard 3 

34 / 153 

 
Select Existing Database 

 
After selecting the existing database you wish to use and clicking Open, the Setup Wizard will take you to 
the Setup options window.  
 
Please continue to the Setup page. 

Setup Options 

  Setup Options 
 
The Setup Window forms part of the Setup Wizard but can also be accessed by clicking Setup in the File 
Menu. 
 

 
File Menu 

 
Setup Window 
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Setup Window 

 
The Setup Window allows you to configure the main PATGuard 3 options, including: 
 
• Company Details 
• User Accounts 
• PAT Options 
• Asset Groups 
 
Please click on the links above for more information about each option. 

Company Details 

  Company Details 
 
The Company Details tab in the Setup Window allows you to enter your company details, including address 
information, phone number, email address and VAT and Company registration numbers. These details will 
appear on any Reports that you generate. 
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Setup - Company Details 

 
Company Logo 
 
The Company Details tab in the Setup Window also allows you to select a company logo to display on any 
Reports that you generate. To do this, click the Browse... button and browse to the location of the logo you 
wish to use. 
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Setup - Browse for new logo 

 
Once you have selected the image you would like to use, click Open to return to the Company Details tab. 
 
Please continue to the User Accounts page. 

User Accounts 

  User Accounts 
 
The User Accounts tab in the Setup Window allows you to Add, Edit and Delete users of PATGuard 3. 
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Setup - User Accounts 

 
Add new user 

 
To add a new user, click the Add.. button in the User Accounts tab in the Setup Window. 

 

 
Add New User 

 
Each user has a user name, an optional password and a Permissions level. 
 
Edit a user 
 
To edit a user, select the user name in the User Accounts tab in the Setup Window and click the Edit... 
button.  
 
Delete a user 
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To delete a user, select the user name in the User Accounts tab in the Setup Window and click the Delete 
button.  
 
Admin user 
 
The default Admin account cannot be renamed, deleted or have the Permissions level changed. It is 
strongly recommended that a password is set for the Admin account to prevent unauthorised access. 
 
Permissions level 
 
There are five options for the Permissions level for PATGuard 3 that limit access to various aspects of 
PATGuard 3 functionality. 
 

 
Permissions Level 

 
The most limited Permissions level is View, which allows a user to look at but not edit the database. The 
highest permissions level is View, Add, Edit, Delete, Setup, which is the same permissions level as the 
default Admin user. 
 
Please continue to the PAT Options page. 

PAT Options 

  PAT Options 
 
The PAT Options tab in the Setup Window allows you to set the Tester Output options and to configure 
Code Abbreviations for use on your tester. 
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Setup - PAT Options 

 
Tester Output 
 
The Tester Output drop-down boxes are used to configure the interpretation of the data downloaded from 
your test instrument. With the exception of the Notes option, all fields are mutually exclusive - in other 
words you cannot set more than one field to Asset Description. 
 
Note that for test instruments that use the SSS download format, the Site, Location and Person information 
in the download will override the options configured in the PAT Options tab. 
 
Please refer to the manual for your test instrument to determine the default Tester Output and other 
download options. 
 
Code Abbreviations 
 
See the Code Abbreviations page for more information on Code Abbreviations. 

Code Abbreviations 

  Code Abbreviations 
 
Code Abbreviations are used to help save time typing on the test instrument. If you wish to use Code 
Abbreviations on your test instrument, and your test instrument is able to use Code Abbreviations, tick the 
Use code abbreviations on tester box in the PAT Options tab.  
 
When this option is enabled text prefixed with a 9 (nine) will be checked against the list of Code 
Abbreviations and, if found, the Code Abbreviation will be expanded. In the example below, 9KET would 
expand to Kettle, 9TOA to Toaster etc. 
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Code Abbreviations 

 
Code Abbreviation Category 
 
Code Abbreviations can be set up for various categories including Asset Description, Location and Person. 
To display the available categories and the Code Abbreviations for each, click on the Show Codes for: 
drop-down box. 
 

 
Code Abbreviation Fields 

 
Adding a new Code Abbreviation 
 
To add a new Code Abbreviation, select the Code Abbreviation Category that you would like to add a new 
Code Abbreviation to. Click the Add button to add a new line. 
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Add a new Code Abbreviation 

 
In the new line, enter the 3-digit Code you would like to use in the Code column. The 9 should not be 
included for the Code in the Code Abbreviation table. Enter the full description in the Represents column. 
 
Editing a Code Abbreviation 
 
To edit either the Code Abbreviation or the full description, simply click in the Code Abbreviations table and 
edit the text accordingly. 
 
Deleting a Code Abbreviation 
 
To delete a Code Abbreviation, select the row containing the Code Abbreviation and hit the Delete button. 
You will be prompted for confirmation. 
 

 
Delete Code Abbreviation 

Asset Groups 

  Asset Groups 
 
An Asset Group defines the test parameters and retest periods for a class of Assets. By defining Asset 
Group and assigning Assets to a group you can manage the retest periods and test codes for many Assets 
at once. In addition to the Pre-defined Asset Groups, Asset Groups can also be Added, Edited or Deleted. 
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Setup - Asset Groups 

 
Pre-defined Asset Groups 
 
In the UK, the Health and Safety Executive (HSE) and the Institute of Engineering and Technology (IET, 
formerly the IEE) define re-test periods in their documentation. These re-test periods are defined in terms of 
the Type of Premises where the Assets are located, the type of equipment, type of test (visual or full test) 
and the class of the equipment (class I or class II).  
 
PATGuard 3 contains a set of pre-defined Asset Groups based on this guidance. Other Asset groups which 
are not premise dependent can be added to Undefined (e.g. Imported Asset Groups or equivalent from 
another database will be in Undefined). 
 
Type of Premises 
 
PATGuard 3 contains a list of Premises Types, each containing a number of pre-defined Asset Groups. 
These Asset Groups can be accessed by selecting the Premises Type from the Type of Premises drop-
down box. 
 

 
Type of Premises 

 
Adding an Asset Group 
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To add a new Asset Group, first select the Type of Premises that you want the Asset Group to belong to, or 
use the < Undefined > premises type, and then click the Add... button to pull up the Asset Group window. 
 

 
Add Asset Group 

 
Enter the description of the Asset Group and select the applicable Class and Voltage. The Default Test 
Period and Default Visual Period allow you to set the default test periods for this asset group, which will be 
used whenever Group Default is selected for Test Period in the Asset Details window.  
 
Default Test Codes can also be entered to instruct your test instrument how to test this group of assets, if 
your test instrument supports Test Codes. Please refer to your test instrument manual for more information 
on Test Codes. 
 
Edit an Asset Group 
 
To edit an Asset Group, select the Asset Group name in the Asset Groups tab in the Setup Window and 
click the Edit... button. This will open the Asset Group window. 
 
Delete an Asset Group 
 
To delete an Asset Group, select the Asset Group name in the Asset Groups tab in the Setup Window and 
click the Delete button. You will be prompted for confirmation. 
 

  
Delete Asset Group 

Navigating PATGuard 3 
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  Navigating PATGuard 3 
 
The PATGuard 3 user interface is split into four main areas, the Title Bar, Ribbon, Navigation Pane and 
Main Window, as shown below. The relative size of the Navigation Pane and Main Window can be adjusted 
by clicking and dragging the dividing bar with the mouse. 
 

 
PATGuard 3 

 
Title Bar 
 
The Title Bar contains the Quick-access Toolbar as well as Minimise, Maximise and Close buttons.  
 
For more information, see the Title Bar page. 
 
Ribbon 
 
The Ribbon provides access to the File, Data Transfer, Functions and Help menus along with the Style 
options.  
 
For more information, see the Ribbon page. 
 
Navigation Pane 
 
The Navigation Pane provides access to the various main PATGuard 3 functions, including PAT Testing, 
Universal Risk Assessment, Site Reports, the Address Book, Reports and Instruments. The Navigation 
Pane also contains the database Tree View. The Navigation Pane can be customised to hide some of 
these features if they are not required.  
 
For more information, see the Navigation Pane page. 
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Main Window 
 
The contents of the Main Window depend on which PATGuard 3 function is selected. For example, when 
using the PAT Testing function, the Main Window displays details of the stored assets and test results. 
 
For more information, see the Main Window page. 
 
Short-cut Keys 
 
There are also a number of short-cut keys in PATGuard 3 to help make common tasks quicker. 
 
For more information, see the Short-cut Keys page. 

The Title Bar 

  The Title Bar 
 
The Title Bar is at the top of the PATGuard 3 user interface and contains the Quick-access Toolbar as well 
as the Minimise, Maximise and Close buttons. 
 

 
Title Bar 

 
Quick-access Toolbar 

 
Quick-access Toolbar 

 
The icons on the Quick-access Toolbar provide options to Create a new database or Open an existing file. 
 
Minimise, Maximise and Close buttons 

 
Minimise, Maximise and Close buttons 

 
The minimise and maximise buttons allow the user to minimise and maximise/restore the PATGuard 3 
window. The close button closes PATGuard 3. 
 
Context Menu 
 
Right-clicking on the Title Bar brings up the Context Menu: 
 

 
Context Menu 

 
The context menu provides options to move, resize, minimise, maximise/restore and close PATGuard 3. 

The Ribbon 
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  The Ribbon 
 
The Ribbon provides access to the File, Data Transfer, Functions and Help menus. 
 
The Ribbon also contains the Application Button, the Style Options menu and a link to the About Screen. 
 

 
The Ribbon 

 
Application Button 
 

 
Application Button menu 

 
The Application Button opens a menu with options to Create a new database or Open an existing file. The 
menu also shows a list of recent documents that are available to open, along with an Exit button. 
 
Minimising and Maximising the Ribbon 
 
The Ribbon can be minimised by double-clicking one of the Menu names (File, Data Transfer, Functions or 
Help). This will hide the Menu bars unless one of the Menu names is selected, and can be useful on low 
resolution screens 
 
Double-clicking on a Menu name will maximise the Ribbon. 

File Menu 

  File Menu 
 

 
File Menu 

 
The File Menu contains the following options: 
 
• New Database 
• Open File 
• Setup 
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• Add Client 
• Add Site 
• Add Location 
• Add Asset/Add Hazard (depending on context) 
• Find 
• Find Next 
• Asset View Filter 
• Last Download Only 
• Auto Schedule 
 
Click on the links above for more information about each option. 
 
Condensed View 
 
If there is not enough space to display the entire menu, the File Menu - and other Ribbon menus - 
automatically condense themselves to save space, as shown below: 
 

 
File Menu - condensed view 

 
The hidden options can be accessed, in this case, by clicking on the 'View' button: 
 

 
File Menu - condensed view (expanded) 

Open an existing file 

  Open an existing file 
 
To open an existing file or database, select Open File from the File Menu (or from the Quick-access 
Toolbar or Application Button).  
 

 
File Menu - Open 

 
This will open the Open File window, which allows you to browse to the file you wish to open. 
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Open File window 

 
File Types 
 
The Open File window allows you to open files of different types. 
 

 
Open File - File Type Options 

 
Opening a Database (.mdb) will close the database that is currently in use and open the selected database. 
Opening any of the Downloads options (.sss, .txt, .gar) or Briefcase (.pat) files will import the data in the 
selected file into the current database. 

Find 

  Find 
 
To search for assets matching particular criteria, select the Find option from the File Menu. 
 

 
File Menu - View - Find/Find Next 
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The fields in the Find window are used to define the search criteria. You can search by Site, Location, 
Asset ID, Description, Asset Group, Serial Number or Next Check Date.  
 
You must select at least one search criteria but the other fields may be left blank. Click OK to begin the 
search. 
 

 
Find Window 

 
The search criteria given must ALL be present in an asset for a match to occur. If a matching asset is found 
the Tree View will display its location and the asset will be selected in the Asset View. 
 
Find Next 
 
Select the Find Next option in the File Menu to continue the search. If another match occurs, the Tree View 
will display the location of the next asset and the asset will be selected in the Asset View. You can also find 
the next match by pressing the F3 key. 
 
If no more matches occur, the following message will be displayed: 
 

 
Find - No Matching Assets 

Asset View Filter 

  Asset View Filter 
 

To filter the Asset View for assets with particular next test dates, select the Asset View Filter option from 
the File Menu. 
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File Menu - View - Asset View Filter 

 
To filter the Asset View by next test date, tick the Filter asset view by next test date box and then change 
the From and To dates according to your requirements. 
 
Alternatively, to view all assets that have tests overdue, tick the Show all assets that have tests overdue 
box. This will disable the From and To date boxes.  
 
If you wish to include visual tests, tick the Include Visual Tests in Schedule box. 

 

 
Asset View Filter window 

 
Clicking OK will apply the Asset View Filter, and only assets matching the filter will be displayed in the 
Asset View. 

Last Download Only 

  Last Download Only 
 
To filter the Asset View so that only assets added or modified by the last download appear, select the Last 
Download Only option from the File Menu. 
 

 
File Menu - View - Asset View Filter 

 
Only the assets added or modified by the last download will appear in the Asset View. Selecting Last 
Download Only again removes the filter so that all assets can be seen. Newly created assets are 

differentiated from modified assets by a icon. 
 
Using the Last Download Only function overrides any previously applied Asset View Filter. 

Data Transfer Menu 

  Data Transfer Menu 
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Data Transfer Menu 

 
The Data Transfer Menu contains the following options: 
 
• Download from tester 
• Upload to tester 
• Export to file 
• Email export 
 
Click on the links above for more information about each option. 

Functions Menu 

  Functions Menu 
 

 
Functions Menu 

 
The Functions Menu contains the following options: 
 
• Auto Scheduler 
• Add Formal Test Visual Pass 
• Emergency Lighting 
• Fire Alarm 
• Create PATGuard Viewer CD 
• PAT Risk Assessment 
• Universal Risk Assessment 
 
Click on the links above for more information about each option. 

Create PATGuard Viewer CD 

  Create PATGuard Viewer CD 
 
PATGuard Viewer is a ‘view’ only version of the program that can be freely issued to Clients and others so 
that they can view the database and print their own Reports.  
 
Not all versions of PATGuard 3 can create a Viewer CD, refer to the PATGuard 3 Versions page for more 
information. 
 
To create a PATGuard 3 Viewer CD, make sure you are using either the PAT Testing, Universal Risk 
Assessment or Site Reports function. Select the Client you wish to create a Viewer CD for in the Tree View 
in the Navigation Pane. Only the data for that Client will be added to the Viewer CD. Alternatively, to 
include the entire database, select the top level of the database in the Tree View in the Navigation Pane.  
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Select a Client or the top level of the database 

 
Select the Create Viewer CD option from the Functions Menu. 

 

 
Functions Menu - Create Viewer CD 

 
This will open the Create Viewer CD Image window, which allows you to set the options for your Viewer 
CD. 
 
Create Viewer CD Image window 

 

 
Create Viewer CD Image window 

 
The PATGuard Viewer CD can be customised by changing the Splash Screen and Company Logo. The 
Splash Screen appears when the PATGuard Viewer is started, and the Company Logo will appear on all 
Reports generated with PATGuard Viewer. 
 
Changing Splash Screen 
 
To change the Splash Screen, select Browse... next to Splash screen (.bmp) to open the Open Splash 
Screen window. 
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Open Splash Screen window 

 
Browse to the location of the Bitmap (.bmp) file that you would like to use as the Splash Screen. Select OK 
to select the file and return to the Create Viewer CD Image window. 
 
Changing Company Logo 
 
To change the Company Logo, select Browse... next to Company logo (.jpg) to open the Open Company 
Logo window. 
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Open Company Logo window 

 
Browse to the location of the JPEG (.jpg) file that you would like to use as the Company Logo. Select OK to 
select the file and return to the Create Viewer CD Image window. 
 
Setting CD image directory 
 
To set the folder you would like to output the Viewer CD image to, select Browse... next to CD image 
directory to open the Browse for CD image directory window. 
 

 
Browse for CD image directory window 
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Browse to the location of the folder that you would like to output the CD image files to (in the example 
above, the previously created ViewerCD folder on the Desktop). Select OK to select the file and return to 
the Create Viewer CD Image window. 
 
NB: The CD image directory should be an empty folder, and never the root directory (e.g. C:\ ) or 
any other important system folder. 
 
Creating Viewer CD image 
 
After setting the various Viewer CD options, select Create CD Image to generate the Viewer CD files. 
Once the Viewer CD files have been generated, copy all of the generated files onto a blank CD or DVD 
using your normal CD creating software program.  
 
It is a good idea to check the Viewer CD has been created correctly by installing on your own PC before 
sending to a Client. 

Add Formal Visual Test Pass 

  Add Formal Visual Test Pass 
 
The Add Formal Visual Test Pass feature allows you to add a visual test pass to the Test Results for one or 
more Assets.  
 
To add a Formal Visual Test Pass to one or more Assets, make sure you are using the PAT Testing 
function and select the Asset or Assets you wish to add a Formal Visual Test Pass to in the Main Window.  
 

 
Selecting multiple Assets in the Main Window 

 
Select Add Formal Visual Test Pass from the Functions Menu. 
 

 
Functions Menu - Add Formal Visual Test Pass 

 
You will be prompted for confirmation. 
 

 
Add Formal Visual Test Pass confirmation 
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Selecting OK will add a visual test pass with the current date to the test results for the selected Asset or 
Assets. 

Help Menu 

  Help Menu 
 

 
Help Menu 

 
The Help Menu contains the following options: 
 
• About PATGuard 3 
• Setup Wizard 
• Help Topics 
 
Click on the links above for more information about each option. 

Style Options 

  Style Options 
 
The appearance of PATGuard 3 can be customised using the Style feature, which can be accessed from 
the top right corner of the Ribbon. As well as the Default Style there are a number of Optional Styles to 
choose from. 
 
Default Style 
 
The default style for PATGuard 3 is "Windows 7". 
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Default "Windows 7" style 

 
Optional Styles 
 
There are four optional styles to choose from; "Office 2007 (Blue Style)", "Office 2007 (Black Style)", "Office 
2007 (Silver Style)" and "Office 2007 (Aqua Style)". 
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Optional styles "Office 2007 (Aqua)", "Office 2007 (Silver)", "Office 2007 (Blue)" and "Office 2007 (Black)" 

The Navigation Pane 

  The Navigation Pane 
 
The Navigation Pane is displayed on the left hand side of the screen. The relative size of the Navigation 
Pane and Main Window can be adjusted by clicking and dragging the dividing bar with the mouse. 
 
The Navigation Pane is split into two areas. The bottom area of the Navigation Pane provides access to the 
main PATGuard 3 functions.The functions displayed in the Navigation Pane can be customised to meet 
your requirements.  
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Functions 

 
Depending on the function selected, the top of the Navigation Pane will display one of the following: 
 
• Tree View 
• Reports View 
• Instruments View 
 
Tree View 
 
The Tree View allows you to navigate the PATGuard 3 database.  
 

 
Tree View 

 
The top of the Tree View shows the top level of the database. Underneath this are displayed the configured 
Clients, Sites and Locations. Parts of the Tree View can be expanded and collapsed using the + and - 
icons the left of a Client or Site. 
 
The Recycle Bin is also shown in the Tree View. 
 
Reports View 
 
The Reports View displays the list of configured report types in the top of the Navigation Pane. 
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Reports 

 
Refer to the Reports section for more information. 
 
Instruments View 
 
The Instruments View displays a list of configured instrument types in the Navigation Pane. 
 

 
Instruments 

 
Refer to the Instruments section for more information. 

Customising the Navigation Pane 

  Customising the Navigation Pane 
 
The Navigation Pane can be customised by hiding, minimising, or rearranging the various PATGuard 3 
function buttons to better meet your requirements. 
 
Hiding functions 
 
Depending on how you wish to use PATGuard 3 and the functions that you will make use of, you may wish 
to hide certain functions from the Navigation Pane. For example, if you do not wish to produce Site Reports 
you may choose to hide this function. 
 
To do this, select the >> button at the bottom of the Navigation Pane to display the Navigation Pane menu. 
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Navigation Pane menu 

 
Select Navigation Pane Options... from the Navigation Pane menu. This will open the Navigation Pane 
Options window. 
 

 
Navigation Pane Options window 

 
Toggling the checkbox next to each function in the Navigation Pane Options window will change whether 
that function is visible or hidden in the Navigation Pane. In the example below, only the PAT Testing and 
Instruments functions are visible. 
 

 
Navigation Pane - only two functions visible 

 
Selecting Reset in the Navigation Pane Options window will set all functions to visible in the Navigation 
Pane. 
 
Minimising functions 
 
Rather than hiding functions, you may wish to simply minimise the functions you use least often. Minimising 
functions also provides more space for the database Tree View. 
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To do this, select the >> button at the bottom of the Navigation Pane to display the Navigation Pane menu. 
 

 
Navigation Pane - Function menu 

 
Select Show Fewer Buttons from the Navigation Pane menu to minimise a function. Functions will be 
minimised in the order that they appear in the Navigation Pane - in the example above, the Instruments 
function will be minimised first. To minimise specific functions, rearrange the functions in the Navigation 
Pane so that the functions you wish to minimise are at the bottom. 

 
In the extreme example below, all of the functions have been minimised. 

 

 
Navigation Pane - All function minimised 

 
PATGuard 3 will automatically minimise and maximise functions when running on a small screen or in a 
small window. 
 
Rearranging functions 
 
You may wish to change the order that functions appear in the Navigation Pane, either to put the functions 
in a specific order or to enable you to minimise particular functions.  
 
To do this, select the >> button at the bottom of the Navigation Pane to display the Navigation Pane menu. 
 

 
Navigation Pane menu 
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Select Navigation Pane Options... from the Navigation Pane menu. This will open the Navigation Pane 
Options window. 
 

 
Navigation Pane Options window 

 
Selecting a function and using the Move Up and Move Down buttons in the Navigation Pane Options 
window will change the order the functions appear in the Navigation Pane. 
 
Selecting Reset in the Navigation Pane Options window will set all functions to the default order in the 
Navigation Pane. 

Recycle Bin 

  Recycle Bin 
 
When Assets, Hazards or Site Reports are deleted they are moved to the Recycle Bin. 
 
Assets, Hazards or Site Reports located in the Recycle Bin can be viewed by selecting Recycled in the 
Tree View. Deleted items corresponding to the current function will be displayed: Assets will be visible 
when using the PAT Testing function, Hazards when using the Universal Risk Assessment function and 
Site Reports when using the Site Reports function. 
 

 
Recycle Bin 

 
The deleted Assets, Hazards and Site Reports will be displayed in the Main Window. 
 
Restoring Assets or Hazards 
 
Deleted Assets, Hazards and Site Reports can be restored by right-clicking them in the Main Window and 
selecting Restore.  
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Restore from Recycle Bin 

 
The asset will be moved from the Recycle Bin back into the main database. 
 
NB: In order for Assets or Hazards to be restored from the Recycle Bin, the Client/Site/Location to 
which they belong must still exist in the database (or be created manually). 

Main Window 

  The Main Window 
 
The Main Window is displayed on the right hand side of the screen. The relative size of the Navigation 
Pane and Main Window can be adjusted by clicking and dragging the dividing bar with the mouse. 
 
Depending on which of the main PATGuard 3 functions is selected, the Main window will display one of the 
following views: 
 
• Asset View 

o Filtering the Asset View 
o Sorting the Asset View 

• Hazard View 
• Site Reports View 
• Personnel View 
• Instruments View 
 
Asset View 
 
The Asset View is shown when the PAT Testing function is selected. The Assets View displays the list of 
Assets for the Client, Site or Location selected in the Tree View on the Navigation Pane. 
 

 
Asset View 

 
Filtering the Asset View 
 
The Assets displayed in the Asset View can be filtered using the Asset View Filter and Last Download Only 
options in the File Menu.  
 
Sorting the Asset View 
 
The Assets displayed in the Asset View can be sorted based on the information in each column of the 
Asset View. To do this, click on the column heading you wish to sort on. The blue triangle will move to that 
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column to show which column the Assets are being sorted on. To reverse the direction of the sort, click the 
column heading again. The blue triangle will change direction to indicate the direction of the sort. 
 
In the example below, the Asset View has been sorted on the Description column in reverse alphabetical 
order. 
 

 
Asset View - Sorted 

 
Hazard View 
 
The Hazard View is shown when the Universal Risk Assessments function is selected. The Hazard View 
displays the list of Hazards for the Client, Site or Location selected in the Tree View on the Navigation 
Pane. 
 

 
Hazard View 

 
Site Reports View 
 
The Site Reports View is shown when the Site Reports function is selected. The Site Reports View displays 
the list of Site Reports for the Client, Site or Location selected in the Tree View on the Navigation Pane. 
 

 
Site Reports View 

 
Personnel View 
 
The Personnel View is shown when the Address Book function is selected. The Personnel View displays 
the External Personnel for the Client, Site or Location selected in the Tree View on the Navigation Pane. If 
the top-level of the database is selected, the Personnel View displays the Internal Personnel. 
 

 
Personnel View 

 
Instruments View 
 
The Instruments View is shown when the Instruments function is selected. The Instruments View displays 
the list of Instruments of the type selected in the Instruments View on the Navigation Pane.  
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Instruments View 

Short-cut Keys 

  Short-cut Keys 
 
A number of common functions in PATGuard 3 can be accessed using the following short-cut keys: 
 

New Database 
Open File 
Find 
Help 
Rename 
Find Next 
Reveal Short-cuts 
Delete 

Ctrl + N 
Ctrl + O 
Ctrl + F 
F1 
F2 
F3 
F10 
Del 

 

PATGuard 3 functions 

  PATGuard 3 functions 
 
The main functions of PATGuard 3 are accessible from the Navigation Pane and are as follows: 
 
• PAT Testing 
• Universal Risk Assessment 
• Site Reports 
• Address Book 
• Reports 
• Instruments 
 

 
PATGuard 3 functions 

 
There are also a number of features common to one or more of the above functions which are accessible 
from the File Menu. These are as follows: 
 
• Clients 
• Sites 
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• Locations 
 
Click on the links above for more information about each function. 

Clients 

  Clients 
 
The details of your customers are stored as Clients in the database. Clients can be added from within the 
PAT Testing, Universal Risk Assessment and Site Reports functions of PATGuard 3. See also Changing 
Client Details and Deleting Clients. 
 
Adding Clients 
 
To add a client click on the Add Client option in the File Menu, as shown below, to bring up the Client 
Details window.  
 

 
Add Client option 

 
You may find that the Add Client option is greyed out, as shown below. 
 

 
Add Client option greyed out 

 
If this is the case, click on the top level of the database Tree View in the Navigation Pane. You will now be 
able to add a client to the database. 
 

 
Top level of database Tree View selected 

 
Client Details 
 
The Client Details window allows you to view, add or amend the contact details of your customers, 
including address, telephone and email details, a reference number and any other notes you would like to 
add about the Client. 
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Client Details window 

 
Personnel responsible for Client 
 
The Personnel button in the Client Details window displays details of Internal Personnel assigned to the 
client. In this case two Internal Personnel have been assigned to this Client, one in an Administration role 
and one in a Technical role. 
 

 
Personnel assigned to Client 

 
Personnel details are stored in the Address Book. See Adding Internal Personnel for more information on 
how to add Internal Personnel and assign them to particular Clients. 

 
Changing Client Details 
 
Client details can be changed at any time by double-clicking the Client name in either the database Tree 
View in the Navigation Pane, or in the Main Window. This will bring up the Client Details window. You can 
also rename a client by right clicking the client name in the Tree View and selecting Rename, or by 
pressing F2 whenever the client is selected. 
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Deleting Clients 
 
Clients can be deleted by selecting them in either the database Tree View in the Navigation Pane, or in the 
Main Window, and pressing Delete. You can also delete a client by right clicking the client name in the 
Tree View and selecting Delete. You will be prompted for confirmation.  
 

 
Delete Client Confirmation 

 
CAUTION: deleting a Client will also delete any locations, assets and results associated with them. 

Sites 

  Sites 
 
The details of addresses where testing is carried out are stored as Sites in the database. Sites can be 
added from within the PAT Testing, Universal Risk Assessment and Site Reports functions of PATGuard 3. 
See also Changing Site Details and Deleting Sites.  
 
Depending on your individual requirements, for example whether you are a contractor or perform in-house 
testing only, sites can be created at the top level of the database or can be associated with a particular 
Client and appear underneath that Client in the Tree View in the Navigation Pane. An example of both 
types of Site is shown below - Site 1 is not associated with a Client, whereas Site 2 is associated with 
Client 1. 
 

 
Two types of Site 

 
Adding Sites 
 
To add a Site click on the Add Site option in the File Menu, as shown below, to bring up the Site Details 
window.   
 

 
Add Site option 

 
You may find that the Add Site option is greyed out, as shown below. 
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Add Site option greyed out 

 
If this is the case, make sure that either the top level of the database or a particular Client is selected within 
the Tree View in the Navigation Pane. You will now be able to add a Site to the database. 

 
Site Details 
 
The Site Details window allows you to view, add or amend the details of a Site, including the name of the 
Site, the Client (this will be pre-populated if you created the site under a Client in the Tree View), address 
and contact details and any other notes you would like to add about the Site.  
 
If the box Site not at client location is not ticked, the fields will automatically contain address and contact 
details of the Client.  
 

 
Site Details window 

 
Attaching photos to Site Details 

 
You can also attach photos of the Site to the Site Details. To do this, click the Add Attachment button in 
the Site Details window. This will open the Open Photo window. 
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Open Photo window 

 
Browse to find the photo you want to attach and click Open to attach the photo to the Site Details. Multiple 
photos can be attached to each Site and comments can be added to each photo. To select the default 
photo for a Site, click the Default photo box in the Site Details window. 
 
You can scroll through the attached photos using the << and >> buttons and delete attached photos using 
the Delete Attachment button. You will be prompted for confirmation.  
 

 
Delete Picture Confirmation 

 
Personnel responsible for Site 
 
The Personnel button in the Site Details window displays details of Internal Personnel responsible for the 
Site. In this case two Internal Personnel have been assigned to this Site, one in an Administration role and 
one in a Technical role. 
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Personnel assigned to Client 

 
Personnel details are stored in the Address Book. See Adding Internal Personnel for more information on 
how to add Internal Personnel and assign them to particular Clients. 
 
Changing Site Details 
 
Site details can be changed at any time by double-clicking the Site name in either the database Tree View 
in the Navigation Pane or in the Main Window. This will bring up the Site Details window. You can also 
rename a Site by right clicking the Site name in the Tree View and selecting Rename, or by pressing F2 
whenever the site is selected. 
 
Deleting Sites 
 
Sites can be deleted by selecting them in either the database Tree View in the Navigation Pane, or in the 
Main Window, and pressing Delete. You can also delete a site by right clicking the site name in the Tree 
View and selecting Delete. You will be prompted for confirmation.  
 

 
Delete Site Confirmation 

 
CAUTION: deleting a Site will also delete any locations, assets and results associated with it. 

Locations 

  Locations 
 
Locations provide a way of dividing Sites into smaller, more manageable sections. Locations can be added 
from within the PAT Testing, Universal Risk Assessment and Site Reports functions of PATGuard 3. See 
also Changing Location Details and Deleting Locations.  
 
The exact meaning of a Location can change depending on your individual requirements. If a Site 
represents a single building, for example, a Location could be a room within that building. If a Site has 
multiple buildings, a Location could be a specific building on that Site. 
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Adding Locations 
 
To add a Location, first select the Site that the Location is to be created at in the Tree View in the 
Navigation Pane. 
 

 
Select a Site 

 
To add the Location click on the Add Location option in the File Menu, as shown below, to bring up the 
Location Details window.   
 

 
Add Location option 

 
Location Details 
 
The Location Details window allows you to view, add or amend the details of a Location, including the 
name and description of a Location, the associated Client and Site (these may already be pre-populated 
with the details of the Client and Site you selected in the Tree View), and any other notes you would like to 
add about the Location. 
 

 
 
Attaching photos to Location Details 

 
You can also attach photos of the Location to the Location Details. To do this, click the Add Attachment 
button in the Location Details window. This will open the Open Photo window. 
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Open Photo window 

 
Browse to find the photo you want to attach and click Open to attach the photo to the Location Details. 
Multiple photos can be attached to each Location and comments can be added to each photo. To select 
the default photo for a Location, click the Default photo box in the Location Details window. 
 
You can scroll through the attached photos using the << and >> buttons and delete attached photos using 
the Delete Attachment button. You will be prompted for confirmation.  
 

 
Delete Picture Confirmation 

 
Changing Location Details 
 
Location details can be changed at any time by double-clicking the Location name in either the database 
Tree View in the Navigation Pane or in the Main Window. This will bring up the Location Details window. 
You can also rename a Location by right clicking the Location name in the Tree View and selecting 
Rename, or by pressing F2 whenever the site is selected. 
 
Deleting Locations 
 
Locations can be deleted by selecting them in either the database Tree View in the Navigation Pane, or in 
the Main Window, and pressing Delete. You can also delete a Location by right clicking the site name in 
the Tree View and selecting Delete. You will be prompted for confirmation.  
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Delete Location Confirmation 

 
CAUTION: deleting a Location will also delete any assets and results associated with it. 

PAT Testing 

  PAT Testing 
 
The PAT Testing function of PATGuard 3, which is accessible from the Navigation Pane, allows you to 
view, add and amend details of Assets, manually add Test Results and perform PAT Risk Assessments. 
 

 
Navigation Pane - PAT Testing 

 
When the PAT Testing function is selected in the Navigation Pane, the Main Window will show the Assets 
associated with whichever Site or Location is selected in the database Tree View, along with details of the 
last and next test dates for those Assets. Items due for tests are highlighted in red.  
 

 
Main Window - Asset View 

 
PAT Testing functions 
 
The main PAT Testing functions of PATGuard 3 are as follows: 
 
• Assets 
• Test Results 
• PAT Risk Assessment 
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Related activities 
 
There are also a number of other features associated with the PAT Testing functions of PATGuard 3. 
These are as follows: 
 
• Clients 
• Sites 
• Locations 
 
Click on the links above for more information about each function. 

Assets 

  Assets 
 
Assets refer to physical items to be tested. PATGuard 3 allows you to add Assets to a particular Site or 
Location, to manually add test results, and also to add PAT Risk Assessments to those Assets.  
 
Viewing and Filtering Assets 
 
To view the Asset Details for a particular Asset, double-click the Asset in the Main Window, or select the 
Asset and press F8. To review Test Results for an Asset, either open the Asset Details window or right click 
the Asset and click Test Results... You can also print an individual Test Certificate from this menu. See 
also Changing Asset Details and Deleting Assets.  
 
You can also filter Assets by certain criteria. For more information on filtering Assets, refer to the Find, 
Asset View Filter and Last Download Only pages. 
 
Manually adding Assets 
 
To add an Asset, first select the Site or Location that the Asset is to be created at in the Tree View in the 
Navigation Pane. 
 

 
Select a Site or Location 

 
To add the Asset click on the Add Asset option in the File Menu, as shown below, to bring up the Asset 
Details window.   
 

 
Add Asset option 

 
Cloning Assets 
 
A quick way to duplicate an Asset, which is useful if you have multiple similar items to add, is to right click 
on the Asset in the Main Window and select Clone. This will create a copy of the Asset, but without any 
Test Results. 
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Clone Asset 

 
Asset Details 
 
The Asset Details window allows you to view, add or amend details of the Asset, including Asset ID, 
Description and Asset Group.The Site and Location will already be populated.  
 

 
Asset Details window 

 
The Asset Details window can also be viewed by double-clicking the Asset in the Main Window, by 
selecting the Asset and pressing F8, or by right-clicking on the Asset and selecting Details... 

 
Advanced Asset Details 
 
The Advanced Asset Detail tab allows you to add additional information about an Asset, including the 
Make, Model and Serial Number. 
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Asset Detail Window - Advanced tab 

 
Default Test Codes can also be entered to instruct your test instrument how to test this group of assets, if 
your test instrument supports Test Codes. Please refer to your test instrument manual for more information 
on Test Codes. 
 
Retest Period 
 
The Retest Period for Full Test and Formal Visual Test can also be set in the Asset Details window. 
 

 
Asset Detail Window - Retest period 

 
The options for Retest Period include: 
 
• No Re-test - no Retest Period is defined 
• User Defined - Retest Period can be manually entered in the Asset Details window and will 

automatically be calculated from the last test date 
• Group Default - the Retest Period will be set based on the Asset Group the Asset belongs to 
• As Risk Assessment - the Retest Period will be set based on the results of a PAT Risk Assessment 
 
Asset Notes 
 
You can add notes about an Asset to the Asset Details. To do this, click the Notes... button in the Asset 
Details window. This will open the Asset Notes window. 
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Asset Notes window 

 
Manually adding Test Results 
 
To manually add Test Results to an Asset, click on Add Results...  in the Asset Details window. 
 
See the Test Results page for more information on manually adding Test Results to an Asset. 
 
Adding a PAT Risk Assessment 
 
To add a PAT Risk Assessment to the Asset, click on Perform Risk Assessment...  in the Asset Details 
window. 
 
See the PAT Risk Assessment page for more information on adding a PAT Risk Assessment to an Asset. 
 
Deleting Test Results or PAT Risk Assessments 
 
To delete Test Results or a PAT Risk Assessment associated with a Asset, select the row containing the 
test results or PAT Risk Assessment  in the Asset Details window and hit the Delete button. You will be 
prompted for confirmation. 
 

 
Delete test results/PAT Risk Assessment 

 
Attaching photos to Asset Details 
 
You can attach photos of the Asset to the Asset Details. To do this, click the Add Attachment button  in 
the Asset Details window. This will open the Open Photo window. 
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Open Photo window 

 
Browse to find the photo you want to attach and click Open to attach the photo to the Asset Details. 
Multiple photos can be attached to each Asset and comments can be added to each photo. To select the 
default photo for a Asset, click the Default photo box in the Asset Details window. 
 
You can scroll through the attached photos using the << and >> buttons and delete attached photos using 
the Delete Attachment button. You will be prompted for confirmation.  
 

 
Delete Picture Confirmation 

 
Changing Asset Details 
 
Asset details can be changed by double-clicking the Asset in the Main Window, by selecting the Asset and 
pressing F8, or by right-clicking on the Asset and selecting Details... This will bring up the Asset Details 
window.  
 
Deleting Assets 
 
Assets can be deleted by selecting them in the Main Window, and pressing Delete. You will be prompted 
for confirmation.  
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Delete Asset Confirmation 

 
Deleted Assets can be restored from the Recycle Bin. 
 
CAUTION: deleting an Asset will also delete any Test Results or PAT Risk Assessments associated 
with it. 

Test Results 

  Test Results 
 
Test Results are linked to individual Assets and store details of visual inspections, electrical tests and PAT 
Risk Assessments associated with that Asset. 
 
View Test Results 
 
To view Test Results for an Asset, open the Asset Details window by double-clicking the Asset in the Main 
Window, by selecting the Asset and pressing F8, or by right-clicking on the Asset and selecting Details... 
Test Results for the Asset are displayed in this window. See also Changing Test Results and Deleting Test 
Results.  
 

 
Asset Details window 

 
Alternatively, right click on the Asset in the Main Window and click Test Results... to open the Test Results 
window and view only the Test Results and not the full Asset Details. 
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Test Results window 

 
The Test Results displayed in either the Asset Details or Test Results windows can be details of visual 
inspections, electrical tests and PAT Risk Assessments associated with that Asset. Double-clicking a Test 
Result in either window will open the Test Details window or the PAT Risk Assessment window, depending 
on the type of Test Result. 
 
Manually adding Test Results 
 
Clicking Add Results... in either the Asset Details or Test Results windows will open a blank Test Details 
window for you to manually enter Test Results. 
 
Test Details window 
 
The Test Details window allows you to view, add or amend details of individual Results for an Asset. For 
electrical tests, you can select the Test Instrument used to associate with the Results. 
 

 
Test Details window 

 
To add a Result, click Add Result in the Test Details window to add a new Result. Select the Test type 
from the available options and enter the Result and Status (whether the Test was a Pass or Fail, for 
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example). You can also select the units, although this will normally be automatically selected for you. 
Continue adding results using the Add Result... button until you have entered the complete sequence of 
tests. If you need to delete a row, select the row and click the Delete Result 
 
Attaching photos to a Test Result 

 
You can also attach photos of the Asset to the Test Result. To do this, click the Add Attachment button in 
the Test Details window. This will open the Open Photo window. 

 

 
Open Photo window 

 
Browse to find the photo you want to attach and click Open to attach the photo to the Test Result. Multiple 
photos can be attached to each Test Result and comments can be added to each photo. To select the 
default photo for a Test Result, click the Default photo box in the Test Details window. 
 
You can scroll through the attached photos using the << and >> buttons and delete attached photos using 
the Delete Attachment button. You will be prompted for confirmation.  
 

 
Delete Picture Confirmation 

 
Delete Result 
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To delete a Test Result, select the row containing the test results or PAT Risk Assessment in the Test 
Details window and hit the Delete Result... button. You will be prompted for confirmation. 
 

 
Delete Test Results 

PAT Risk Assessment 

  PAT Risk Assessment 
 
PAT Risk Assessments can be performed directed from the Asset Details window by clicking the Perform 
Risk Assessment... button. They can also be performed by clicking on an Asset in the Main Window and 
selecting PAT Risk Assessment from the Function Menu, as shown below, to bring up the PAT Risk 
Assessment window.  
 

 
PAT Risk Assessment option 

  
PAT Risk Assessment window 
 
The PAT Risk Assessment window allows you to view or complete a PAT risk assessment for an Asset. 
Entering details about the Asset and the environment at the Site or Location will automatically calculate a 
recommended Retest Period.  
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PAT Risk Assessment window 

 
Attaching photos to a PAT Risk Assessment 

 
You can also attach photos of the Asset to the PAT Risk Assessment. To do this, click the Add 
Attachment button in the PAT Risk Assessment window. This will open the Open Photo window. 
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Open Photo window 

 
Browse to find the photo you want to attach and click Open to attach the photo to the PAT Risk 
Assessment. Multiple photos can be attached to each PAT Risk Assessment and comments can be added 
to each photo. To select the default photo for a PAT Risk Assessment, click the Default photo box in the 
PAT Risk Assessment window. 
 
You can scroll through the attached photos using the << and >> buttons and delete attached photos using 
the Delete Attachment button. You will be prompted for confirmation.  
 

 
Delete Picture Confirmation 

Universal Risk Assessment 

  Universal Risk Assessment 
 
The Universal Risk Assessment function of PATGuard 3, which is accessible from the Navigation Pane, 
allows you to view, add and amend details of Hazards and perform Universal Risk Assessments. 
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Navigation Pane - Universal Risk Assessment 

 
When the Universal Risk Assessment function is selected in the Navigation Pane, the Main Window will 
show the Hazards associated with whichever Site or Location is selected in the database Tree View.  
 

 
Main Window - Hazard View 

 
Universal Risk Assessment functions 
 
The main Universal Risk Assessment functions of PATGuard 3 are as follows: 
 
• Hazards 
• Perform Universal Risk Assessment 
 
Related activities 
 
There are also a number of other features associated with the Universal Risk Assessment functions of 
PATGuard 3. These are as follows: 
 
• Clients 
• Sites 
• Locations 
 
Click on the links above for more information about each function. 

Hazards 

  Hazards 
 
PATGuard 3 allows you to add Hazards to a particular Site or Location, and also to add Universal Risk 
Assessments to those Hazards.  
 
Manually adding Hazards 
 
To add a Hazard, first select the Site or Location that the Hazard is to be created at in the Tree View in the 
Navigation Pane. See also Changing Hazard Details and Deleting Hazards.  
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Select a Site or Location 

 
To add the Hazard click on the Add Hazard option in the File Menu, as shown below, to bring up the 
Hazard Details window.   
 

 
Add Hazard option 

 
Hazard Details 
 
The Hazard Details window allows you to view, add or amend details of the Hazard, including Hazard ID 
and Description, and to perform a Universal Risk Assessment for the Hazard. The Site and Location will 
already be populated.  
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Hazard Details window, including a Universal Risk Assessment 
 
The << and >> buttons can be used to view the previous/next Hazard at that Site or Location. 
 
Adding a Universal Risk Assessment 
 
To add a Universal Risk Assessment to the Hazard, click on Perform Risk Assessment...  
 
See the Perform Universal Risk Assessment page for more information on adding a Universal Risk 
Assessment to a Hazard. 
 
Deleting a Universal Risk Assessment 
 
To delete a Universal Risk Assessment associated with a Hazard, select the row containing the Universal 
Risk Assessment and hit the Delete button. You will be prompted for confirmation. 
 

 
Delete Universal Risk Assessment 

 
Changing Hazard Details 
 
Hazard details can be changed by double-clicking the Hazard in the Main Window. This will bring up the 
Hazard Details window.  
 
Deleting Hazards 
 
Hazards can be deleted by selecting them in the Main Window, and pressing Delete. You will be prompted 
for confirmation.  
 

 
Delete Hazard Confirmation 

 
Deleted Hazards can be restored from the Recycle Bin. 
 
CAUTION: deleting a Hazard will also delete any Universal Risk Assessments associated with it. 

Perform Universal Risk Assessment 

  Perform Universal Risk Assessment 
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Universal Risk Assessments can be performed directed from the Hazard Details window. They can also be 
performed by clicking on a Hazard in the Main Window and selecting Universal Risk Assessment from 
the Function Menu, as shown below, to bring up the Universal Risk Assessment window.  
 

 
Universal Risk Assessment option 

  
Universal Risk Assessment window 
 
The Universal Risk Assessment window allows you to view or complete a risk assessment of the Hazard. 
The Hazard ID, Site, Location, and Username will already be populated.  
 

 
Universal Risk Assessment window 

 
Add Action 
 
From within the Universal Risk Assessment, corrective actions can be added by clicking the Add Action 
button. This will add an Action to the bottom of the Universal Risk Assessment, as shown below. 
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Universal Risk Assessment - Add Action 

 
Multiple actions can be added to a single Universal Risk Assessment. 

 
Attaching photos to Universal Risk Assessment 

 
You can also attach photos of the Hazard to the Universal Risk Assessment. To do this, click the Add 
Attachment button in the Universal Risk Assessment window. This will open the Open Photo window. 
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Open Photo window 

 
Browse to find the photo you want to attach and click Open to attach the photo to the Universal Risk 
Assessment. Multiple photos can be attached to each Universal Risk Assessment and comments can be 
added to each photo. To select the default photo for a Universal Risk Assessment, click the Default photo 
box in the Universal Risk Assessment window. 
 
You can scroll through the attached photos using the << and >> buttons and delete attached photos using 
the Delete Attachment button. You will be prompted for confirmation.  
 

 
Delete Picture Confirmation 

Site Reports 

  Site Reports 
 
The Site Reports function of PATGuard 3, which is accessible from the Navigation Pane, allows you to 
view, add and amend details of Site Reports relating to particular Sites and Locations. 
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Navigation Pane - Site Reports 

 
When the Site Reports function is selected in the Navigation Pane, the Main Window will show the Site 
Reports associated with whichever Site or Location is selected in the database Tree View.  
 

 
Main Window - Site Report View 

 
Site Reports functions 
 
The main Site Reports functions of PATGuard 3 include the ability to add, view and amend the following 
reports: 
 
• Emergency Lighting 
• Fire Alarm 
 
Related activities 
 
There are also a number of other activities associated with the Site Reports functions of PATGuard 3. 
These are as follows: 
 
• Clients 
• Sites 
• Locations 
 
Click on the links above for more information about each function. 

Emergency Lighting 

  Emergency Lighting 
 
PATGuard 3 allows you to create an Emergency Lighting Site Report for a given Site or Location. See also 
Changing Emergency Lighting Site Reports and Deleting Emergency Lighting Site Reports. 
 
To add an Emergency Lighting Site Report, first select the Site or Location that you wish to create an 
Emergency Lighting Site Report for in the Tree View in the Navigation Pane. 
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Select a Site or Location 

 
Next click on the Emergency Lighting option in the Functions Menu, as shown below, to bring up the 
Emergency Lighting Site Report window. 
 

 
Site Reports - Emergency Lighting 

 
Emergency Lighting Site Report 
 
The Emergency Lighting Site Report window allows you to view or complete an Emergency Lighting 
assessment for a given Site or Location. Some fields will already be populated with Client or Site details. 
 

 
Emergency Lighting Site Report window 

 
Editing an Emergency Lighting Site Report 
 
To edit an Emergency Lighting Site Report, double-click the Emergency Lighting Site Report in the Main 
Window to bring up the Emergency Lighting Site Report window. 
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Deleting an Emergency Lighting Site Report 
 
To delete an Emergency Lighting Site Report, select the Emergency Lighting Site Report in the Main 
Window and hit the Delete button. You will be prompted for confirmation. 
 

 
Delete Emergency Lighting Site Report 

 

Fire Alarm 

  Fire Alarm 
 
PATGuard 3 allows you to create a Fire Alarm Site Report for a given Site or Location. See also Changing 
Fire Alarm Site Reports and Deleting Fire Alarm Site Reports. 
 
To add a Fire Alarm Site Report, first select the Site or Location that you wish to create a Fire Alarm Site 
Report for in the Tree View in the Navigation Pane. 
 

 
Select a Site or Location 

 
Next click on the Fire Alarm option in the Functions Menu, as shown below, to bring up the Fire Alarm Site 
Report window. 
 

 
Site Reports - Fire Alarm 

 
Fire Alarm Site Report 
 
The Fire Alarm Site Report window allows you to view or complete a Fire Alarm assessment for a given 
Site or Location. Some fields will already be populated with Client or Site details. 
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Fire Alarm Site Report window 

 
Editing a Fire Alarm Site Report 
 
To edit a Fire Alarm Site Report, double-click the Fire Alarm Site Report in the Main Window to bring up the 
Fire Alarm Site Report window. 
 
Deleting a Fire Alarm Site Report 
 
To delete a Fire Alarm Site Report, select the Fire Alarm Site Report in the Main Window and hit the Delete 
button. You will be prompted for confirmation. 
 

 
Delete Fire Alarm Site Report 

 

Address Book 

  Address Book 
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The Address Book function, which is accessible from the Navigation Pane, allows you to view, add and 
amend details of Personnel. These Personnel can either be Internal Personnel or External Personnel. 
 

 
Navigation Pane - Address Book 

 
When the Address Book is selected in the Navigation Pane, the Main Window will show the External 
Personnel associated with whichever Client, Site or Location is selected in the database Tree View. If the 
top level of the Database is selected in the Tree View, the Main Window will show the Internal Personnel. 
 

 
Main Window - Address Book View 

 
Internal Personnel 
 
Internal personnel are staff that you employ or that otherwise work on your behalf. They can be either 
Technical or Administration staff and can be assigned responsibility for individual clients and sites.  
 
See Adding Internal Personnel for more information. 
 
External Personnel 
 
External personnel are staff associated with a particular Client, Site or Location. They act as a contact for 
that Client, Site or Location and can receive relevant Reports by email. 
 
See Adding External Personnel for more information. 

Adding Internal Personnel 

  Adding Internal Personnel 
 
Internal personnel are staff that you employ or that otherwise work on your behalf. They can be either 
Technical or Administration staff and can be assigned responsibility for individual Clients and Sites. See 
also Changing Internal Personnel Details and Deleting Internal Personnel. 
 
To add new Internal Personnel, select the Address Book from the Navigation Pane.  
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Navigation Pane - Address Book 

 
Select the top level of the database in the Tree View.  

 

 
Top level of database Tree View selected 

 
The Main Window will show the names of any Internal Personnel that have already been added. Click on 
Add Personel... in the Main Window to add new Internal Personnel. 
 

 
Main Window - Address Book View 

 
Internal Personnel Details 
 
The Internal Personnel Details window allows you to view, add or amend the details of the Internal 
Personnel, including address, telephone and email details and whether they are Administration or 
Technical staff. 
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Internal Personnel Details 

 
Responsibility for Clients and Sites 
 
The Internal Personnel Details window is also used to assign responsibility for Clients or Sites to a 
particular staff member. A list of available Clients and Sites appears in the Available Clients/Sites box. To 
assign responsibility for a particular Client or Site, use the >> button to move the Client or Site to the 
Responsibilities box. To remove responsibility for a particular Client or Site, use the << button to more the 
Client or Site back to the Available Clients/Sites box. 
 
In the example below, John Smith is responsible in a Technical role for Client 1 and Site 1, but not Site 2. 
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Personnel Details Window - Site/Client Responsibility 

 
Changing Internal Personnel Details 
 
Internal Personnel details can be changed by double-clicking the name of the Internal Personnel in the 
Main Window. This will bring up the Internal Personnel Details window.  
 
Deleting Internal Personnel 
 
Internal Personnel can be deleted by selecting  the name of the Internal Personnel in the Main Window and 
pressing Delete. You will be prompted for confirmation. 
 

 
Delete Personnel Confirmation 

Adding External Personnel 

  Adding External Personnel 
 
External personnel are staff associated with a particular Client, Site or Location. They act as a contact for 
that Client, Site or Location and can receive relevant Reports by email. See also Changing External 
Personnel Details and Deleting External Personnel. 
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To add new External Personnel, select the Address Book from the Navigation Pane.  
 

 
Navigation Pane - Address Book 

 
Select the Client, Site or Location that you wish to associate the External Personnel with in the database 
Tree View.  

 

 
Client 1 selected in Tree View 

 
The Main Window will show the names of any External Personnel that have already been added for that 
Client, Site or Location. Click on Add Personel... in the Main Window to add new External Personnel. 
 

 
Main Window - Address Book View 

 
External Personnel Details 
 
The External Personnel Details window allows you to view, add or amend the details of the External 
Personnel, including telephone and email details. 
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External Personnel Details 

 
Changing External Personnel Details 
 
External Personnel details can be changed by double-clicking the name of the External Personnel in the 
Main Window. This will bring up the External Personnel Details window.  
 
Deleting External Personnel 
 
External Personnel can be deleted by selecting  the name of the External Personnel in the Main Window 
and pressing Delete. You will be prompted for confirmation. 
 

 
Delete Personnel Confirmation 

Reports 

  Reports 
 
The Reports function of PATGuard 3, which is accessible from the Navigation Pane, allows you to generate 
Reports from the information in the PATGuard 3 database, such as Test Reports and Certificates, and also 
Invoices and Repair Management.  
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Navigation Pane - Reports 

 
When the Reports function is selected in the Navigation Pane, the Tree View will be replaced with the list of 
the available reports.  

 

 
Navigation Pane - Available Reports 

 
Reports functions 
 
There are a number of tasks that can be completed from within the Reports function. 
 
• List of Reports 
• Generating a Report 
• Printing or saving to file 

o Saving a Report to file 
o Print a Report 
o Emailing a Report 

• Editing Reports 
o Copying a Report 
o Deleting a Report 
o Restoring a Report 

• Repair Management 
• Invoicing 
 
Click on the links above for more information about each function. 

List of Reports 

  List of Reports 
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PATGuard 3 comes with a number of pre-configured default Reports for different applications: 
 
• Concise Asset List 
• Detail Asset List 
• Concise Task Checklist 
• Concise Latest Test Results 
• Detailed Latest Test Results 
• Electrical Test Summary 
• Test Certificates 
• Certificate of Testing 
• Invoice 
• List charges 
• Short Code Details 
• Universal Risk Assessment 
 
These Reports are available from the Navigation Pane when the Reports function is selected. 
 

 
Navigation Pane - Available Reports 

 
Reports can be copied, edited, deleted and restored as required. See also Generating a Report and 
Printing or saving to file. 

Generating a Report 

  Generating a Report 
 
The list of available Reports is available from the Navigation Pane when the Reports function is selected. 
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Navigation Pane - Available Reports 

 
Reports are generated by double-clicking the Report you wish to generate, or by right-clicking on the report 
and selecting Print... or Print preview... The basic process of Generating a Report is the same for each 
report, although the options you will be asked to select will vary depending on the report type.  
 
Reports Example - Certificate of Testing 
 
In this example we will generate a Certificate of Testing. Double-click Test Certificates in the Reports View 
in the Navigation Pane. This will open the Certificate of Testing window. Select the Client, Site and 
Location you wish to generate Test Certificates for, or use the <all> option. You can also enter some text to 
add to the Test Certificate. Click OK to generate the Test Certificates. 
 

 
Reports - Certificate of Testing 

 
Once the Test Certificates have been generated the Preview window will open. 
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Reports - Certificate of Testing preview 

 
From the Preview window you can Print, Save or Email your report. See also copying, editing, deleting and 
restoring Reports. 

Printing or saving to file 

  Printing or saving to file 
 
After Generating a Report, the Report can be Saved, Printed or Emailed as required from the Reports 
Preview window.  
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Reports - Certificate of Testing preview 

 
Saving Reports to a file 
 
To save a Report to a file, click the Save icon in the menu bar of the the Reports Preview window to open 
the Save As window. 
 

 
Saving a Report 
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There are a number of options of file types that Reports can be saved as, although .pdf and .jpg are the 
most common. Some file types have additional options that can be set by selecting Options... The Reports 
Preview window has its own Help file to guide you through the options. To open the Reports Preview Help 
file, press F1 while the Reports Preview is open. 

 
Printing Reports 

 
To print a Report to a file, click the Print Current Page or Print all Pages icon in the menu bar of the 
Reports Preview window. 
 

 
Printing a Report 

 
There are a number of print options to choose from. The Reports Preview window has its own Help file to 
guide you through the options. To open the Reports Preview Help file, press F1 while the Reports Preview 
is open. 
 
Emailing Reports 
 
To email a Report, click the Email icon in the menu bar of the the Reports Preview window to open the 
Email window. 
 

 
Emailing a Report 

 
After selecting the desired options, click OK to open your default email program and attach the Report to 
an email. 
 
There are a number of options of file types that Reports can be emailed as, although .pdf and .jpg are the 
most common. Some file types have additional options that can be set by selecting Options... The Reports 
Preview window has its own Help file to guide you through the options. To open the Reports Preview Help 
file, press F1 while the Reports Preview is open. 
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Editing Reports 

  Editing Reports 
 
PATGuard 3 allows you to edit a Report to better meet your requirements. To edit a Report, right click on 
the Report in the Reports View on the Navigation Pane and select Edit... This will open the Reports 
Designer window. 
 

 
Reports Designer window 

 
The Reports Designer has its own Help file to guide you through the editing process. To open the Reports 
Designer Help file, press F1 while the Reports Designer is open or select the ? symbol from the menu bar. 
 
Copying a Report 
 
You can create a copy of a Report by right click on the Report in the Reports View on the Navigation Pane 
and select Copy... This will open the Copy Report window. Enter a name for the Report and select OK. 
 

 
Copy Report window 

 
You will see a window confirming that the Report has been copied successfully. 
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Copy Report confirmation 

 
The new Report will now appear in the Reports View on the Navigation Pane. 
 
Deleting a Report 
 
You can delete a Report by right click on the Report in the Reports View on the Navigation Pane and select 
Delete... You will be prompted for confirmation. 
 

 
Delete Report window 

 
You will see a window confirming that the Report has been deleted successfully. 
 

 
Copy Report confirmation 

 
If you delete a default Report by mistake, it can be Restored if required. 
 
Restoring a Report 
 
If you have edited or deleted a default Report and wish to restore it, right click on the Report in the Reports 
View on the Navigation Pane and select Restore... This will open the Restore Report window. Select the 
name of the Report you wish to Restore and select OK. 
 



PATGuard 3 

112 / 153 

 
Restore Report 

 
You will be prompted for confirmation. 

 

 
Restore Report 

 
You will see a window confirming that the Report has been restored successfully. 
 

 
Restore Report 

 
The restored Report will now appear in the Reports View on the Navigation Pane. 

Repair Management 
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  Repair Management 
 
PATGuard 3 allows you to manage repairs and keep track of the costs involved. 
 
Setting up Repairs 
 
Repair costs can be entered in the Test Details window.  
 

 
Test Details window 

 
To add a repair, follow the procedure to Add Test Results Manually. Under Test type enter details of the 
repairs undertaken. Enter the cost of the repair under Result, and make sure that Status is set to Repair. 
You can also add any comments associated with the repair. 
 

 
Add Repair 

 
Printing Repair details 
 
To print details of repairs, generate an Invoice in the normal way and ensure that Repairs is ticked. 
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Generate Invoice 

 
The generated Invoice will display details of the repair and the cost involved so that the Client can be billed. 
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Generated Invoice 

Invoicing 

  Invoicing 
 
PATGuard 3 allows you to generate Invoices so that the Client can be billed for work undertaken. To 
generate an Invoice, double-click Invoice in the Reports View in the Navigation Pane to open the Invoice 
window. 
 

 
Navigation Pane - Available Reports 

 
Invoice Window 
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The Invoice window allows you to select the Client, Site and Location you wish to generate an Invoice for, 
along with the price per test for various test types, invoice number, order reference, discounting and any 
other notes that you wish to add. You can also select the types of Charges to be included, including Tests, 
Risk Assessments and Repairs. Once you have entered the details, click OK to generate the Invoice. 
 

 
Invoice window 

 
Once the Invoice has been generated, the Reports Preview window will open. 
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Invoice Preview 

 
From the Preview window you can Print, Save or Email your invoice.  

Instruments 

  Instruments 
 
The Instruments function of PATGuard 3, which is accessible from the Navigation Pane, allows you to 
manage your Test Instruments. See Tester Compatibility for a list of test instruments that are compatible 
with PATGuard 3. 
 

 
Navigation Pane - Instruments 
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When the Instruments function is selected in the Navigation Pane, the Tree View will be replaced with a list 
of configured Instrument types.  
 

 
Navigation Pane - Configured Instrument Types 

 
Selecting All Instruments will display all of the configured Instruments in the Main Window. Selecting a 
particular Instrument type will display all configured Instruments of that type in the Main Window (for 
example, all of the configured Apollo 600 Instruments). 
 

 
Main Window - All Instruments 

 
Instrument functions 
 
There are a number of tasks that can be completed from within the Instruments function. 
 
• Adding Test Instruments 
• Entering Calibration Data 
• Adding Test Sequences 
 
There are also a number of other features related to the Instruments function. 
 
• Downloading from your tester 
• Uploading to your tester 
 
Click on the links above for more information about each function. 

Adding Test Instruments 

  Adding Test Instruments 
 
PATGuard 3 allows you to store details of your Test Instruments, including Calibration Data, as Instruments 
in the database. 
 
To add a new Test Instrument, select Instruments from the Navigation Pane. See also Changing Instrument 
Details and Deleting Instruments. 
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Navigation Pane - Instruments 

 
The Main Window will now show the currently configured Test Instruments. Click on Add Test 
Instrument... in the Main Window to open the Test Instrument window to add a new Test Instrument. 

 

 
Main Window - All Instruments 

 
Test Instrument window 
 
The Test Instrument window allows you to view, add or amend the details of a Test Instrument, including 
Instrument Type, Serial Number, and Calibration and Communications settings.  
 
The Instrument tab in the Test Instrument window allows you to select the Instrument Type and enter the 
Serial Number. 
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Test Instrument - Instrument tab 
 
Calibration 
 
The Calibration tab shows details of the Instrument calibration.  
 
See Entering Calibration Data for more information on adding, editing or deleting Test Certificates for an 
Instrument. 
 

 
Test Instrument - Calibration tab 

 
Communications 
 
For instruments that transfer data to and from the PC using serial communications, the Communications 
tab allows you to set the Bits per second, Data bits, Parity and Stop bits settings.  
 
Please refer to your test instrument manual for more information on Communications settings. 
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Test Instrument - Communication tab 

 
Changing Instrument Details 
 
Instrument details can be changed at any time by double-clicking the Instrument name in the Main Window 
or by right-clicking on the Instrument in the Main Window and selecting Details... This will bring up the Test 
Instrument window.  
 
Deleting Instruments 
 
Instruments can be deleted by selecting them in the Main Window, and pressing Delete. You can also 
delete an Instrument by right clicking the Instrument in the Main Window and selecting Delete. You will be 
prompted for confirmation.  
 

 
Delete Instrument Confirmation 

 
CAUTION: deleting an Instrument will also delete any calibration certificates associated with the 
Instrument. 

Entering Calibration Data 

  Entering calibration data 
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PATGuard 3 allows you to store details of your Test Instrument Calibration Test Certificates in the 
database. 
 
To add a Test Certificate, open the Calibration tab of the Test Instrument window. See also Changing Test 
Certificates and Deleting Test Certificates.  
 

 
Test Instrument window - Calibration tab 

 
Select Add... to open the Test Certificate window. 
 
Test Certificate window 
 
The Test Certificate window allows you to enter details of a Calibration Test Certificate, including the Test 
House contact details, the Certificate Number and the Test Date. 
 

 
Test Certificate window 
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Click OK to add the Test Certificate. 
 
Changing Test Certificates 
 
Test Certificate details can be changed at any time by selecting them in the Calibration tab of the Test 
Instrument window and selecting Edit... This will bring up the Test Certificate window.  
 
Deleting Test Certificates 
 
Test Certificates can be deleted by selecting them in the Calibration tab of the Test Instrument window and 
selecting Delete. You will be prompted for confirmation.  
 

 
Delete Test Certificate Confirmation 

Adding Test Sequences 

  Adding Test Sequences 
 
PATGuard 3 allows you to create custom Test Sequences for compatible Test Instruments, such as the 
Seaward SuperNova Elite. 
 
Please refer to your test instrument manual for more information on whether you can add custom Test 
Sequences. 
 
To add a custom Test Sequence, select a compatible Instrument type from the list of configured 
Instruments in the Navigation Pane. See also Uploading Test Sequences, Changing Test Sequences and 
Deleting Test Sequences.  
 

 
Navigation Pane - Select compatible Instrument 

 
When a compatible Instrument type is selected, the option Add Test Sequence will appear in the Main 
Window. 

 

 
Main Window - Add Test Sequence 

 
Double-click Add Test Sequence in the Main Window to open the Test Sequence Details window. 

 
Test Sequence Details window 
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The Test Sequence Details window allows you to enter details of the Test Sequence including the Test 
Sequence name, the specifics of the tests to be carried out, and whether the test should Include Visual 
Inspection and Include Polarity Test. 
 
For each of the available tests, in this case Socket, Earth Bond, Insulation, Substitute Leakage, Flash, 
Leakage, Touch Leakage and RCD Test, select from the list of options for Output, Limit, Test Duration 
and No. of Tests. For any tests you do not wish to include in the Test Sequence, set Limit to Skip. 
 

 
Test Sequence Details window 

 
Click OK to add the Test Sequence. The Test Sequence will now appear in the Main Window. 
 

 
Main Window - New Test Sequence 

 
Uploading Test Sequences 
 
To upload a Test Sequence to your tester, ensure the compatible Instrument is connected to the PC. Right-
click the Test Sequence name in the Main Window and select Upload Test Sequence. 
 
Changing Test Sequences 
 
Test Sequences can be changed at any time by double-clicking the Test Sequence name in the Main 
Window or by right-clicking on the Test Sequence in the Main Window and selecting Details... This will 
bring up the Test Sequence Details window.  
 
Deleting Test Sequences 
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Test Sequences can be deleted by selecting them in the Main Window, and pressing Delete. You can also 
delete a Test Sequence by right clicking the Test Sequence in the Main Window and selecting Delete. You 
will be prompted for confirmation.  
 

 
Delete Test Sequences Confirmation 

Data Transfer 

  Data Transfer 
 
The Data Transfer functions of PATGuard 3 are accessible from the Data Transfer Menu and are as 
follows: 
 
• Downloading from your tester 

o Finding the correct COM port 
o Preview 
o Duplicate Assets 

• Uploading to your tester 
o Uploading configuration data 

• Export to file 
• Export to Email 
• Backing up your database 
 

 
Data Transfer Menu 

 
There are also a number of other features of PATGuard 3 that are related to data transfer: 
 
• Create a new database 
• Open an existing file 
• Import a legacy database 
 
Click on the links above for more information about each option. 

Downloading from your tester 

  Downloading your tester 
 
To Download from your tester, first configure your Test Instrument. Then select Download from tester 
from the Data Transfer menu. 
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Data Transfer - Download 

 
This will open the Download window. 
 

 
Download window 

 
Select the Instrument you wish to download from, the COM port used and the data you wish to download 
and select OK. If you need to change the COM port settings, select Settings... You may also choose to 
Preview the download. 
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COM port settings window 

 
Select OK to start the data download. 

 

 
Data download in progress 

 
Apollo Download 
 
If you are downloading from an Apollo Instrument there are additional options to choose from in the 
Download window, including the Source Directory (the location of your Apollo data) and which data to 
include in the Download. 
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Apollo Download window 

 
Select Browse... to open the Browse for Folder window and select the Apollo directory. 
 

 
Browse for Folder window 

Finding the correct COM port 

  Finding the correct COM port 
 
The details of how to find the correct COM port for your Instrument will vary depending upon the Operating 
System you are using, however the basic principal will work with all Operating Systems. 
 
Firstly, without your Instrument connected, open Device Manager from the Control Panel and expand the 
Ports (COM & LPT) section to show the currently connected ports. 
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Device Manager - No Instrument connected 

 
Now connect your Instrument and wait for your computer to recognise it. You should see a new COM port 
listed in the Device Manager. In this case, the Instrument appears as USB Serial Port (COM10). 
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Device Manager - Instrument on COM10 

 
In this case, when Downloading or Uploading to this Instrument, COM10 is the correct COM port to use. If 
you encounter problems communicating with your Instrument, make sure the Communications settings are 
correct. 

Preview 

  Preview 
 
The download Preview can be selected from the Download window. 
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Download window 

 
Preview allows you to review and edit the downloaded data prior to adding it to the database. You can edit 
the details of a test, delete a test and replace all occurrences of a site or location name in the data. 
 
Process processes the download data into the current database. 
 
Cancel closes the Preview and does not process the data. 

Duplicate Assets 

  Duplicate Assets 
 
When Downloading from your tester, if duplicate items exist PATGuard 3 will alert you and ask you to 
confirm what action you would like to take. 

Uploading to your tester 

  Uploading to your tester 
 
To Upload to your tester, first configure your Test Instrument. Then select Upload from tester from the 
Data Transfer menu. 
 

 
Data Transfer - Upload 

 
This will open the Upload window. 
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Upload window 

 
Select the Instrument you wish to upload to, the COM port used and the data you wish to upload and select 
OK. If you need to change the COM port settings, select Settings... 
 

 
COM port settings window 

 
Apollo Upload 
 
If you are uploading to an Apollo Instrument there are additional options to choose from in the Upload 
window, including the Unit Drive (the location of your Apollo drive) and which data to include in the Upload. 
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Apollo Upload window 

Uploading configuration data 

  Uploading configuration data 
 
To Upload configuration data to your tester, first configure your Test Instrument. Then right-click on the item 
you wish to Upload to your tester and select Upload Site Names..., Upload Location Names... etc. from 
the menu. This will open the Upload window. 
 
Select the Instrument you wish to upload to and the COM port used (if applicable) and select OK. 
 

 
Upload Configuration Data window 

 

Export to File 

  Export to File 
 
Data in the PATGuard 3 database can be exported to either a .pat Briefcase file or a .csv Spreadsheet. 
See also Open an existing file. 
 
To Export to a File, select the Client, Site or Location you wish to export from the Tree View. Alternatively, 
to export a single Asset or Hazard, select that Asset or Hazard in the Main Window. Select to File from the 
Data Transfer menu. 
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Data Transfer Menu - Export 

 
This will open the Save As window, which allows you to browse to the location you wish to export the file to. 
 

 
Save As window 

 
Exporting to .pat file 
 
To export to a .pat file, select Briefcase files (*.pat) from the Save as type: drop-down box. .pat files can be 
used to transfer sections of the database to other PATGuard users. 
 
Exporting to .csv file 
 
To export to a .csv file, select Spreadsheet (*.csv) from the Save as type: drop-down box. .csv files can be 
opened and edited in programs such as Microsoft Excel. 
 
NB: .csv exports do not include photos or risk assessments 

Email 

  Email 
 
Data in the PATGuard 3 database can be exported via email. 
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To Export to Email, select the Client, Site or Location you wish to export from the Tree View. Alternatively, 
to export a single Asset or Hazard, select that Asset or Hazard in the Main Window. Select Email from the 
Data Transfer menu. 
 

 
Data Transfer Menu - Export 

 
This will open a new email in your default email program with the data you selected attached as a .pat file. 
 
See also Open an existing file for details on how to open a .pat file. 

Backing up your database 

  Backing up your database 
 
To avoid losing data if anything happens to your PC, we recommend regularly backing up your PATGuard 
3 database. 
 
Making a backup copy of your database 
 
To make a backup of you database: 
 
1. Close PATGuard 3 if it is open. 
2. Open an Explorer window and browse to the location you specified when Setting up your database. 
3. Right-click on the PATGuard 3 database file to bring up the context menu. Select Copy. 
4. Browse to the location you wish to backup the database to, for example a memory stick or external 

hard drive. Right-click to bring up the context menu and select Paste. 
 
You may alternatively choose to burn a copy of your database to a CD or DVD, or use one of the many on-
line backup services to secure your valuable data. 
 
Seaward recommends backing up your database on a regular basis, at least weekly if you use PATGuard 3 
on a regular basis. 
 
Restoring your database from a backup copy 
 
To restore a database from a backup copy: 
 
1. Copy the backup database to a suitable location on your PC. 
2. Open the backup database following the procedure in Select an existing database. 

Auto Scheduler 

  Auto Scheduler 
 
The Auto Scheduler function of PATGuard 3 is accessible from the Functions Menu and provides a way to 
schedule testing based on a set of trigger conditions. The main features of the Auto Scheduler are as 
follows: 
 
• Setting up a schedule 

o Local launch 
o Remote launch 

• Viewing a schedule 
• Uploading a schedule 
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• Printing a task checklist 
 

 
Functions Menu - Auto Scheduler 

 
When a database with an Auto Scheduler configuration is closed in PATGuard 3 a check is run on that 
database by PATGuard e-Scheduler (running in the PATGuard e-Manager program on the system tray). If 
the trigger conditions are met the configured action is taken. You can check the action taken by double 
clicking on the PATGuard e-Manager icon on the system tray to view its message log. 

 
Click on the links above for more information about each option. 

Setting up a schedule 

  Setting up a schedule 
 
To set up an Auto Schedule, switch to the PAT Testing function and select a Client, Site or Location from 
the Tree View in the Navigation Pane. Select Auto Scheduler from the Functions Menu to open the Auto 
Scheduler window. 
 

 
Functions Menu - Auto Scheduler 

 
Auto Scheduler window 
 
The Auto Scheduler window allows you to select the Client Name, Site Name and Location Name that you 
wish to run an Auto Schedule for.  
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Auto Scheduler window 

 
Schedule launch settings 
 
Exclude this level excludes this part of the database from Auto Schedules. Sub-levels may be included if 
they have their own Auto Scheduler configuration. For example, it is possible to exclude a Client but have 
the Auto Scheduler configured for the Sites below that Client. 
 
Defer up to next level takes the Auto Scheduler configuration from the level above. For example, all 
Locations at a Site could use the Auto Scheduler configuration for the Site. 
 
Launch schedule when trigger conditions are met is used to configure particular Auto Scheduler actions 
for this level of the database. The options are Local launch or Remote launch. 
 
Local launch 
 
If a local schedule is triggered then the next time the database is opened a message will be displayed to 
say that a new schedule is available. The schedule can be viewed, uploaded or printed. 
 
Remote launch 
 
If a remote schedule is triggered an email Report, similar to the Concise Task Report, will be sent as 
configured in the Configure Email window. PATGuard e-Manager can be used to configure the email 
account to be used. 
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Configure Email window 
 
The Configure Email window allows you to set the details of the email sent if a remote schedule is 
triggered. This includes the email address the message should be sent to (from the Address Book), the 
Reply To address, the subject and message, and the level of detail included in the email, including whether 
a quote is attached to the email. 
 

 
Configure Email window 

 
Trigger Conditions 
 
Test type allows you to select whether the trigger should be based on Full tests only or Visual tests only. 
 
If All overdue is selected, a trigger will occur only if all Assets are overdue at this branch of the database. 
 
If Any overdue within period is selected, a trigger will occur if there are any overdue Assets at this branch 
of the database within the time specified. 
 
If Percentage overdue is selected, a trigger will occur if more than the specified percentage of Assets are 
overdue at this branch of the database. 
 
Pre Trigger allows you to specify the number of weeks in advance of the trigger becoming true you would 
like the schedule to be generated (e.g. 4 weeks before all items are overdue). 

Viewing a schedule 

  Viewing a schedule 
 
When a database with an Auto Scheduler configuration is closed in PATGuard 3 a check is run on that 
database by PATGuard e-Scheduler (running in the PATGuard e-Manager program on the system tray). If 
the trigger conditions are met the configured action is taken. You can check the action taken by double 
clicking on the PATGuard e-Manager icon on the system tray to view its message log. 
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If a local schedule is triggered then the next time the database is opened in PATGuard 3 a message will be 
displayed to say that a new schedule is available.  
 

 
Auto Schedule notification 

 
The schedule can be viewed, printed or uploaded. To view the Auto Schedule, select Display from the 
Auto Schedule menu on the File menu. 
 

 
Auto Schedule menu 

 
If a remote schedule is triggered then an email report, similar to the Concise Task Report, will be 
dispatched as configured in the Configure Email window. PATGuard e-Manager can be used to configure 
the email account to be used. 
 

Uploading a schedule 

  Uploading a schedule 
 
To Upload the data associated with an Auto Schedule, select Upload from the Auto Schedule menu on the 
File menu. You can choose to Upload Full Tests or Upload Visual Tests. 
 

 
Auto Schedule menu 

Printing a task checklist 

  Printing a task checklist 
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A Task Checklist can be printed by selecting Print... from the Auto Schedule menu on the File menu. 
 

 
Auto Schedule menu 

 
You can also print a Task Checklist by running a Concise Task Checklist Report. 
 

 
Navigation Pane - Available Reports 

Support 

  Support 
 
If you are having problems using PATGuard 3 software and cannot find an answer to your question in the 
Help file then you can contact Seaward. 
 
To keep up to date with the latest PATGuard 3 news, get support from the Seaward team and other 
PATGuard 3 users, or to make suggestions for how we could improve PATGuard 3, please visit our online 
forum. 
 
If you require technical support on any other Seaward products please visit our website which holds a bank 
of information on our testers, software and electrical safety testing in general. 
 
Licensing 
 
For specific queries about the PATGuard 3 licence, please refer to the following sections: 
 
• Licence FAQs 
• Licence Renewal 
• Licence Agreement 

Licence FAQs 
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  Licence FAQs 
 
How long is left on my licence? 
How many PCs can the licence be used on? 
How do I transfer the licence? 
How do I extend my licence? 
How do I buy an additional licence? 
What happens when my licence expires? 
 
How long is left on my licence? 
 
Select Licence... on the About Screen to open the Licence Viewer. The Licence Viewer will display a list of 
Modules, including PATGuard 3. Next to the PATGuard 3 Module will be a licence expiry date. 
 
How many PCs can the licence be used on? 
 
Each licence is for one standalone PC or network Server only. If used on a network Server the user will 
have a 'floating' licence that can be used on any PC on the network that has followed the instructions on 
the Installing on a network Workstation page. 
 
How do I transfer the licence? 
 
To transfer your licence to a different PC, select Deactivate Licence from this PC... at the Login screen.  
 

 
Login screen 

 
PATGuard 3 will contact the Activation Service to deactivate your licence. Click Close when done. 
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Online Deactivation 

 
To reactivate on the same PC, select Reactivate Existing Serial Number on the login screen. 

 

 
Login screen after deactivation 

 
How do I extend my licence? 
 
During the last 30 days of your licence you will be shown the number of days remaining when you start 
PATGuard 3 and be given a link to follow to renew your licence. After expiry you will be reminded that the 
licence has expired. See What happens when my licence expires.  
 
When you have purchased a new Activation Key, select Apply Renewal Key on the login screen. 
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Login Screen 

 
Enter your Activation Key on the following screen and select OK. 
 

 
Enter Activation Key 

 
How do I buy an additional licence? 
 
Additional Licences are only available to customers that already have a valid (not expired) licence. 
Customers should contact their Distributor or Seaward directly for more information. 
 
What happens when my licence expires? 
 
PATGuard 3 will become read-only until the licence is renewed. You will have view-only access to all data 
but will not be able to use any of the PATGuard 3 features. 

Licence Renewal 

  Licence Renewal 
 
Renewing on a PC with internet access 
 
To renew on a PC with internet access, select Apply Renewal Key Renew on the login screen. 
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Login Screen 

 
Enter your renewal key in the following screen and select OK: 
 

 
Enter Activation Key 

 
PATGuard 3 will contact the Activation Service to verify your Activation Key: 
 

 
Activation in progress 

 
You will receive confirmation that Activation has completed successfully: 
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Activation Successful 

 
Renewing on a PC without internet access 
 
To renew on a PC without internet access, please contact Seaward to receive a renewal Activation Key. 

Licence Agreement 

  Licence Agreement 
 
The licence agreement for PATGuard 3 can also be viewed from the About Screen. 
 
Licence Agreement 
 

 
Seaward Electronic Limited 

Software Licence 

IMPORTANT NOTICE - PLEASE READ THESE TERMS CAREFULLY BEFORE INSTALLING THE 

SOFTWARE.  

This licence agreement (Licence) is a legal agreement between you (you or your) and Seaward Electronic 

Limited of 18 Bracken Hill, South West Industrial Estate, Peterlee, County Durham, SR8 2SW with 

company number 01674384 (us, we or our) for: 

• PATGuard 3 computer software (Software); and 

• related materials and documentation (Documentation).  

We licence use of the Software and Documentation to you on the basis of this Licence. We do not sell the 

Software or Documentation to you. We remain the owners of the Software and Documentation at all times.  

This Licence applies to any trial use of the Software and Documentation, and any subsequent purchase of 

the Software and Documentation. 

Important notice to all users 

1. By trialling, downloading, installing, ordering and using the Software through our website at 

www.seaward.co.uk (Website) you agree to the terms of this Licence which will bind you (and your 

employees where relevant).  The terms of this Licence include, in particular, limitations on 

liability in condition 7. 

http://www.seaward.co.uk
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2. If you do not agree to the terms of this Licence, we will not license the Software and 

Documentation to you and you will not be able to continue with the download and installation 

process.   

3. Please note that the Seaward Returns Policy does not apply to the purchase of Software and 

Documentation.  You have the right to cancel your transaction without charge and without reason 

before confirming your purchase of the Software or Documentation.  However, you will lose your 

right to cancel your transaction once you accept this Licence as part of the purchase process.  This 

will not affect any consumer rights in respect of defective downloaded Software or Documentation 

purchased through our Website. 

You should print a copy of these Licence arrangements for future reference. 

1. Supply of the Software 

1.1 For the steps you need to take to arrange a trial and to place an order for the Software and 

Documentation through our Website, please visit www.seaward.co.uk/patguard3.   

1.2 Our order process allows you to check and amend any errors before submitting your order to us.  

Please take the time to read and check your order at each page of the order process. 

1.3 After you place an order, you will receive an email from us acknowledging that we have received 

and accepted your order.     

1.4 Our email will also confirm the details of the Software and contain a link from which the Software 

and Documentation can be downloaded or provide an authorisation code following your trial of the 

Software (Order Confirmation).  The Contract between us will only be formed when we send you 

the Order Confirmation.   

2. Grant and Scope of Licence 

2.1 In consideration of the payment of the licence fee for the Software and Documentation (Fee), we 

hereby grant to you a non-exclusive, non-transferable licence to download and use the Software 

and the Documentation on the terms of this Licence only for the duration set out in the Order 

Confirmation. 

2.2 You may: 

2.2.1 install and use the Software for your personal purposes (if you are a consumer) or your 

internal business purposes (if you are a business) only on one computer; 

2.2.2 provided it is used on only one computer at any one time, transfer the Software from one 

computer to another by following the procedure on our Website; 

http://www.seaward.co.uk/patguard3
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2.2.3 provided you comply with the provisions in condition 3.1, make one (1) copy of the 

Software for back-up purposes; 

2.2.4 receive and use any free supplementary software code or update of the Software 

incorporating "patches" and corrections of errors as may be provided by us from time to 

time; 

2.2.5 use any Documentation in support of the use permitted under condition 2.2 and make one 

(1) copy of the Documentation as reasonably necessary for its lawful use. 

2.3 The Software requires the following minimum system requirements for its operation: 

2.3.1 1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor; 

2.3.2 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit); 

2.3.3 16 GB available hard disk space (32-bit) or 20 GB (64-bit); 

2.3.4 DirectX 9 graphics device with WDDM 1.0 or higher driver; 

2.3.5 .Net 4.0. 

2.4 You acknowledge and agree that where your systems utilise Microsoft software, the Software can 

only be supported by us where such Microsoft software and systems continue to be supported by 

Microsoft. 

3. Restrictions 

3.1 Except as expressly set out in this Licence or as permitted by any local law, you undertake:  

3.1.1 not to copy the Software or Documentation except where such copying is incidental to 

normal use of the Software or where it is necessary for the purpose of back-up or 

operational security; 

3.1.2 not to sell, rent, lease, sub-license, loan, translate, merge, adapt, vary or modify the 

Software or Documentation; 

3.1.3 not to make alterations to, or modifications of, the whole or any part of the Software nor 

permit the Software or any part of it to be combined with, or become incorporated in, any 

other programs; 

3.1.4 not to disassemble, de-compile, reverse engineer or create derivative works based on the 

whole or any part of the Software nor attempt to do any such things except to the extent 

that (by virtue of section 296A of the Copyright, Designs and Patents Act 1988) such 

actions cannot be prohibited because they are essential for the purpose of achieving inter-
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operability of the Software with another software program, and provided that the 

information obtained by you during such activities: 

3.1.4.1 is used only for the purpose of achieving inter-operability of the Software with 

another software program; 

3.1.4.2 is not disclosed or communicated without our prior written consent to any third 

party to whom it is not necessary to disclose or communicate it; and 

3.1.4.3 is not used to create any software which is substantially similar to the Software; 

3.1.5 to keep all copies of the Software secure and to maintain accurate and up-to-date records 

of the number and locations of all copies of the Software; 

3.1.6 to supervise and control use of the Software and ensure that the Software is used by your 

employees and representatives (where appropriate) in accordance with the terms of this 

Licence; 

3.1.7 to include our copyright notice on all entire and partial copies of the Software in any form; 

and 

3.1.8 not to provide, or otherwise make available, the Software in any form, in whole or in part 

(including, but not limited to, program listings, object and source program listings, object 

code and source code) to any person other than your employees without prior written 

consent from us. 

4. How to Pay 

4.1 The Fee for the Software and Documentation shall be as set out on our Website from time to time. 

4.2 You shall pay to us the Fee as set out in the Order Confirmation, in advance, by PayPal or by debit 

and credit card.  We accept the following cards: Visa, Visa Credit, Visa Debit, Purchasing Card and 

MasterCard.  

4.3 All sums payable under this Licence are exclusive of VAT or any other relevant local sales taxes, 

for which you shall be responsible. 

4.4  If you fail to pay any amount payable to us under this Licence, we may charge you interest on the 

overdue amount (payable immediately on demand) from the due date for payment up to the date of 

actual payment at the rate of 4% per annum above the base rate for the time being of the Bank of 

England.  Such interest shall accrue on a daily basis and shall be compounded quarterly.  As an 

alternative, and at our sole discretion, we may also claim interest under the Late Payment of 

Commercial Debts (Interest) Act 1998. 
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5. Intellectual Property Rights 

5.1 You acknowledge that all intellectual property rights in the Software and the Documentation 

throughout the world belong to us (or our licensors), that rights in the Software are licensed (not 

sold) to you, and that you have no rights in, or to, the Software or the Documentation other than the 

right to use them in accordance with the terms of this Licence. 

5.2 You acknowledge that you have no right to have access to the Software in source code form or in 

unlocked coding or with comments. 

6. Limited Warranty 

6.1 We warrant that: 

6.1.1 the Software will, when properly used and on an operating system for which it was 

designed, perform substantially in accordance with the functions described in the 

Documentation; and 

6.1.2 that the Documentation correctly describes the operation of the Software in all material 

respects  

for a period of 90 days from the date of purchase of the Software and confirmation of acceptance of 

this Licence (Warranty Period).     

6.2 If, within the Warranty Period, you notify us in writing of any defect or fault in the Software as a 

result of which it fails to perform substantially in accordance with the Documentation, we will, at our 

sole option, either repair or replace the Software. 

6.3 The warranty does not apply: 

6.3.1 if the defect or fault in the Software results from you having amended the Software; 

6.3.2 if the defect or fault in the Software results from you having used the Software in 

contravention of the terms of this Licence;  

6.3.3 if the defect or fault in the Software results from damage to the Software or your computer 

caused after you have downloaded the Software;  

6.3.4 if the defect or fault in the Software results from installation on a system that is no longer 

supported by Microsoft; or 

6.3.5 during any trial of the Software prior to purchase. 

6.4 The Software may be used in conjunction with hardware supplied by third parties.  Please refer to 

the manufacturer's guarantee (where relevant) for details. 
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6.5 If you are a consumer, this warranty is in addition to your legal rights in relation to Software that is 

faulty or not as described. Advice about your legal rights is available from your local Citizens' 

Advice Bureau or Trading Standards office. 

7. Limitation of Liability  

7.1 You acknowledge that the Software has not been developed to meet your individual requirements, 

and that it is therefore your responsibility to ensure that the facilities and functions of the Software 

as described in the Documentation meet your requirements. 

7.2 If you are a business customer, we only supply the Software and Documentation for internal use by 

your business, and you agree not to use the Software or Documentation for any re-sale purposes.  

7.3 We shall not under any circumstances whatever be liable to you, whether in contract, tort (including 

negligence), breach of statutory duty, or otherwise, arising under or in connection with the Licence 

for: 

7.3.1 loss of profits, sales, business, or revenue; 

7.3.2 business interruption; 

7.3.3 loss of anticipated savings; 

7.3.4 loss or corruption of data or information; 

7.3.5 loss of business opportunity, goodwill or reputation; or 

7.3.6 any indirect or consequential loss or damage. 

7.4 Other than the losses set out in condition 7.3 (for which we are not liable), our maximum aggregate 

liability under or in connection with this Licence whether in contract, tort (including negligence) or 

otherwise, shall in all circumstances be limited to a sum equal to 100% of the Licence Fee. This 

maximum cap does not apply to condition 7.5. 

7.5 Nothing in this Licence shall limit or exclude our liability for: 

7.5.1 death or personal injury resulting from our negligence; 

7.5.2 fraud or fraudulent misrepresentation; 

7.5.3 any other liability that cannot be excluded or limited by English law. 

7.6 This Licence sets out the full extent of our obligations and liabilities in respect of the supply of the 

Software and Documentation. Except as expressly stated in this Licence, there are no conditions, 

warranties, representations or other terms, express or implied, that are binding on us.  Any 

condition, warranty, representation or other term concerning the supply of the Software and 
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Documentation which might otherwise be implied into, or incorporated in, this Licence whether by 

statute, common law or otherwise, is excluded to the fullest extent permitted by law. 

7.7 If you are a consumer, we are only responsible for loss or damage you suffer that is a foreseeable 

result of our breach of this Licence or our negligence up to the amount specified in condition 7.4, 

but we are not responsible for any loss or damage that is not foreseeable.  Loss or damage is 

foreseeable if they were an obvious consequence of our breach or if they were contemplated by 

you and us at the time we granted you the Licence. 

8. Duration and Termination 

8.1 Unless terminated earlier in accordance with this condition 9, the Licence shall continue for the 

duration set out in the Order Confirmation, when it shall automatically terminate. 

8.2 We may terminate this Licence immediately by written notice to you if you commit a material or 

persistent breach of this Licence which you fail to remedy (if remediable) within 14 days after the 

service of written notice requiring you to do so.  

8.3 We may terminate this Licence where the Software has been installed on a system operating 

Microsoft software, and that Microsoft software is no longer supported by Microsoft. 

8.4 Upon termination for any reason: 

8.4.1 all rights granted to you under this Licence shall cease; 

8.4.2 you must immediately cease all activities authorised by this Licence; 

8.4.3 you must immediately pay to us any sums due to us under this Licence; and 

8.4.4 you must immediately delete or remove the Software from all computer equipment in your 

possession and immediately destroy or return to us (at our option) all copies of the 

Software then in your possession, custody or control and, in the case of destruction, certify 

to us that you have done so. 

9. Communications Between Us 

9.1 If you are a consumer, if you wish to contact us in writing, or if any condition in this Licence 

requires you to give us notice in writing, you can send this to us by e-mail or by pre-paid post to 

Seaward Electronic Limited at software@seaward.co.uk. We will confirm receipt of this by 

contacting you in writing, normally by e-mail.  

9.2 If we have to contact you or give you notice in writing, we will do so by e-mail or by pre-paid post to 

the address you provide to us in your order for the Software. 

mailto:software@seaward.co.uk
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9.3 If you are a business customer, please note that any notice given by you to us, or by us to you, will 

be deemed received and properly served immediately when posted on our website, 24 hours after 

an e-mail is sent, or three days after the date of posting of any letter. In proving the service of any 

notice, it will be sufficient to prove, in the case of a letter, that such letter was properly addressed, 

stamped and placed in the post and, in the case of an e-mail, that such e-mail was sent to the 

specified e-mail address of the addressee. 

10. Events Outside Our Control 

10.1 We will not be liable or responsible for any failure to perform, or delay in performance of, any of our 

obligations under this Licence that is caused by an Event Outside Our Control.  An Event Outside 

Our Control is defined below in clause 10.2. 

10.2 An Event Outside Our Control means any act or event beyond our reasonable control, including 

without limitation failure of public or private telecommunications networks. 

10.3 If an Event Outside Our Control takes place that affects the performance of our obligations under 

this Licence: 

10.3.1 our obligations under this Licence will be suspended and the time for performance of our 

obligations will be extended for the duration of the Event Outside Our Control; and 

10.3.2 we will use our reasonable endeavours to find a solution by which our obligations under 

this Licence may be performed despite the Event Outside Our Control. 

11. Other Important Terms 

11.1 We may transfer our rights and obligations under this Licence to another organisation, but this will 

not affect your rights or our obligations under this Licence.  

11.2 You may only transfer your rights or your obligations under this Licence to another person if we 

agree in writing. 

11.3 If you are a business customer, this Licence and any document expressly referred to in it 

constitutes the entire agreement between you and us. You acknowledge that you have not relied 

on any statement, promise or representation made or given by or on behalf of us which is not set 

out in this Licence or any document expressly referred to in it. 

11.4 If we fail to insist that you perform any of your obligations under this Licence, or if we do not 

enforce our rights against you, or if we delay in doing so, that will not mean that we have waived 

our rights against you and will not mean that you do not have to comply with those obligations. If 
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we do waive a default by you, we will only do so in writing, and that will not mean that we will 

automatically waive any later default by you.  

11.5 Each of the conditions of this Licence operates separately. If any court or competent authority 

decides that any of them are unlawful or unenforceable, the remaining conditions will remain in full 

force and effect.  

11.6 If you are a consumer, please note that this Licence, its subject matter and its formation, are 

governed by English law. You and we both agree to that the courts of England and Wales will have 

non-exclusive jurisdiction. However, if you are a resident of Northern Ireland you may also bring 

proceedings in Northern Ireland, and if you are resident of Scotland, you may also bring 

proceedings in Scotland. 

11.7 If you are a business customer, this Licence, its subject matter and its formation (and any non-

contractual disputes or claims) are governed by English law. We both agree to the exclusive 

jurisdiction of the courts of England and Wales.  

 
 


